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From the Editor

Greetings one and all!

I can't even begin to express how grateful I am for all the help, all the 
contributions, all the ideas and input that have been tossed around to make this issue 
happen. I can only say: "Thank you from the bottom of my heart to all of the staff and 
contributors that put such hard work into this. May this be the beginning of an 
evermore enjoyable and inspiring teamwork."

With that said, dear readers, I hope you'll all enjoy reading the product of our 
labor. "Progress" is the word that came to my mind when I thought about this issue, 
particularly in line with adding the new web-mag format of the PADD. You will find 
that many articles echo that word in one way or another. 

There should be something for everyone. We have news briefings for those who 
like to stay informed, technical and science articles for the inquisitive mind, log writing 
tips to help you draw more readers, a graphics tutorial for those that like arts, fan 
fiction, recipes, comics, gossip, and other entertaining tidbits that call on your 
feedback.

Talking about feedback, please don't hesitate to give it. You can use the 
feedback link at the bottom of the PADD website's main navigation page - all you 
have to do is fill out the blanks - or you can always send your responses to 
usfpadd@sector001.com via email.

Ideas, input, and praise are always appreciated. - We'd love to hear from you!

Lori
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Briefings

USF Fleet

“Ad-Lib”

Lost in translation:

CaptainCrain: Costa?  Statto molto bene?  You are molting?  Get a grip man.

– Commodore Booker in his alter ego as Captain Crain on First Lieutenant Costa's attempt to  
bring some Italian culture to the Lothlorien

Typical male:

USFDiell: Are you suspecting spy devices in there?
RydekkLhidan: You never know, sir.
RydekkLhidan: We don't even know what exactly it is, or even the size. For all we do 
know, it could be hidden inside a phaser.
USFHavraha: (Could be worse.  You could be holding her spare bra as she asks that.)

– during a USS Ares sim

Impeccable logic:

Lt_Katel: Do denibian slime devils use spores to reproduce?
CaptSHawks: No....they go to a motel like the rest of us.

– after a USS Federation sim

Have any interesting lines from one of your sims? Send them our way! We'd love to share the fun 
and laughs. Use the feedback link (select “PADD Editor”). For verification purposes, the date of 

the sim from which the information is taken must be included.
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Promotions and Appointments

August 2010
• First Lieutenant Kaysen Jarv, USS Agamemnon, was promoted to Lieutenant 

Commander on 201008.31.
• Lieutenant Junior Grade Jethro MacIntyre, Starbase Everest, was promoted to 

Full Lieutenant.
• Cadet Maxx, currently working in the Engineering department of SS Nigala 

while also doing his academic studies, was promoted to 4th-year Cadet.

September 2010
• On 201009.03, Commodore Shane Booker was reassigned and Captain 

Cay'Leb Crain took command of the USS Lothlorien.
• Ensign Air of Din, USS Agamemenon, was promoted to Lieutenant Junior Grade 

on 201009.07.
• In addition to her responsibilities as Chief Medical Officer on the Roddenberry, 

First Lieutenant N`alae Leónsbanner took on the responsibilities of Ship's 
Counselor.

• First Lieutenant Rrhuann, USS Roddenberry, was appointed to serve as the 
Acting Chief Engineer on 201009.14.

• Lieutenant Amira Starr, USS Agamemenon, was promoted to First Lieutenant on 
201009.14.

• Lieutenant Commander Simon Trent, SS Nigala, was appointed to serve as 
Second Officer on 200909.15.

• Private Uriel Veltrin (Marine), USS Agamemenon, was promoted to Second 
Lieutenant on 201009.07.

October 2010
• Commander Briana Santori was promoted to Captain and appointed 

Commanding Officer of the USS Agamemnon on 201010.12.
• On 201010.26, Lieutenant Commander Simon Trent was appointed as 

Operations Manager for the USS Agamemnon.

Congratulations to everyone!!

Been promoted lately? Let us know, so we can announce your milestone here! Please submit 
your promotional information using the feedback link (select “Promotions”), or send it to 

USFBooker@aol.com.
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Intel
reported by 
Cadet Malachi Styles, First Lieutenant Solik, and First Lieutenant Leyva Torosi

Outpost Phoenix
Recruiting: Engineering Officers, Science Officers, Medical Officers, Civilians, 
Entrepreneurs, Shop Keepers, and more colonists! 

Space Station Nigala
Simming: The crew boarded the USS Trieste to respond to a distress call from the 
Alpha Quadrant, finding the USS Huntington under attack by two factions with which 
we have a treaty. The Trieste is now caught in the cross-fire, but manages to mount a 
rescue operation to the Huntington.
Recruiting: All departments.

Special Operations Group
Simming: At last report SOG was busy maneuvering a dangerous minefield and a 
cluster of possibly hostile ships.
Recruiting: Existing USF members with a desire to participate in the USF's premier 
specialty sim. 

SB Everest
Simming: Everest been busy wrapping up a mission in the Beta Quadrant assisting the 
Rinic resolving issues with their new astronomical facility, helping them with repairs 
and offering medical assistance.
Recruiting: All departments.

Starfleet Academy
Simming: The cadets of Starfleet Academy are all gearing up for the 2387- 88 school 
year. Already they have experienced a murder, and the abduction of one of the 
Lagier cadets.
Recruiting: Cadets to train in almost all fields of study.

USS Agamemnon
Simming: The crew of the Agamemnon has been stranded on a planet in the 
Gamma Quadrant after forcing to abandon the ship after an assault, resulting in a 
fake warp core breach. Every day, the crew has learned more about the planet than 
simply what's on the surface.
Recruiting: All departments.

USS Aldrin
Recruiting: Helm, Operations and Security/Tactical.
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USS Ares
Simming: The USS Ares received a faint distress signal and managed to find the source 
at the opposite end of an unstable wormhole. The wormhole led to an area of space 
where no stars are visible, where the Ares also found itself - facing itself - although 
forty-two years older and with an unfamiliar crew, claiming to be the children of the 
original Ares.
Recruiting: Helm, Security/Tactical, Engineering, Science and Medical.

Columbia
Simming:  The Columbia experiences a molecular deterioration of her anti-matter 
injectors and was forced to deliver an important ambassador to Starfleet command 
before blowing up the ship. They hoped to get some shore leave in then.
Recruiting: Science, Engineering, Security, and Medical. 

USS Darmok
Simming: The Darmok is heading for a non-Federation planet called Yotaga III in 
response to a distress call. The Yotagan's have requested help with a natural disaster 
from anyone in the vicinity.
Recruiting: Engineering, Security.

USS Eclipse
Simming: In an alternate universe, the Eclipse is involved in a mission to covertly 
obtain a Romulan cloaking device without alerting the target to their presence.
Recruiting: Engineering and Medical officers.

Excelsior
Simming: The command and crew of the Excelsior have been chasing after some 
portal jumping ships, which have a power beam that deteriorates their enemies' ships 
and buildings. Thus far the crew have not been able to see the "face" of these 
mysterious ones, just their ships.
Recruiting: Engineering and Science.

USS Federation
Simming: The USS Federation is investigating strange readings coming from a planet 
at the Federation/Klingon border. An away team is on the surface, checking out an 
underground mine and running into trouble.
Recruiting: All departments.

Hermes
Simming: The Hermes is assigned to escort the crown prince of Beximil back home 
because his father, the High King has passed away. Beximil is applying for Federation 
membership, and keeping the prince happy and comfortable is paramount.
Recruiting: Medical and Helm.
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Indedpendence
Simming: The recently cloned crew of the Independence is now finding themselves 
with double of everyone, after they had to disable the Keeper, an automated bot, 
who had started cloning them. It had not counted on the myriad of different species 
populating the ship, and the clones actually had started breaking down to puddles 
of ooze, but the crew were able to revive all of them.
Recruiting: All Departments, as well as an Intelligence Liaison Officer.

Lexington
Simming: The USS Lexington is marooned in low orbit around K'nonax Hydra III. They 
have been offere assistance from the inhabitants, but for a price... to get involved in 
a local scuffle with another race, but the Lexington's captain refused.
Recruiting: Security and Science officers, and anyone willing to play random civilian 
Science team members.

USS Lothlorien
Simming: The Lothlorien is the forerunner in an exploration and expansion operation. 
It's currently three months away from Federation space in the Alpha Quadrant, 
exploring uncharted space. So far, they've found planets for the Federation to send 
colonization projects too, as well as opportunities for first contact encounters.
Changes: As the Nova-class USS Lothlorien-C was destroyed, the Lothlorien-D is reborn 
as an Intrepid-class starship, on 201009.03.
Recruiting: Medical, Engineering, Security/Tactical and a Counselor.

USS Odyssey
Simming: The Odyssey crew recently participated in a holodeck training simulation in 
which they retook control of their hijacked shuttle and succeeded in beating the 
scenario.
Recruiting: Engineering, Tactical, Security, Science, and Medical.

USS Potemkin
Announcement: The Potemkin Sim strives for a sim filled with action, mystery and yes 
drama (The good kind as "acting" is "drama"). Our focus is on in depth role-playing, 
where character development is not only encouraged but the name of the game. 
The only limits are the ones you put on yourself. We explore the far reaches of space, 
heal the diseased, rescue people, and kick butt when it's called for. For all this and 
more join the Potemkin!
Recruiting: The Potemkin has just returned from a summer hiatus and is now recruiting 
for positions in all departments!

USS Roddenberry
Simming: The Roddenberry was recently commandeered by Captain Heath Rowell, 
who also implemented several re-assignments for the duration of a secret mission, of 
which the entire directive has not been made aware to the crew. After dealing with 
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Pakleds to retrieve information, the ship is now headed for Cardassian space.
Recruiting: Helm, Engineering, Science, Security/Tactical and Medical.

Announcements

New Feature for the USF Core

Need a quick character description or want to put your character's picture up? 
We've got just the page for you. Presenting the newest addition to the USF Core: the 
Character Stats page!

For more information:
• http://core.sector001.com/cgi-bin/board.cgi?thread=506&post=12

[back to table of contents]
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Star Trek

Memorable Quotes

"Let me dream."

– Gene Roddenberry

Acting is easier - writing is more creative. The lazy man vies with the industrious.

– William Shatner

Intel
reported by Ensign Knomic Brott

Nimoy's Photo Exposition

Any Star Trek simmer knows Leonard Nimoy as Spock, but some may forget he is 
an accomplished photographer. His one-person photo exposition, titled “Secret 
Selves,” is on display at the Massachusetts Museum of Contemporary Art through 
January 2, 2011. It features twenty-six color photographs of people who, through his 
encouragement, revealed their inner selves: a painter looking like a wood sprite, a 
leather-clad rabbi, a teenager dressed as a shark, and an advertising executive 
dressed as a wizard, among others. Of particular interest to simmers is Nimoy’s 
inspiration for this exhibition: a section of Plato’s “Symposium” in which humans are 
split apart by gods, destined to chase after their lost other halves. Sound familiar to 
any simmers out there who, week to week, chase their alter egos across the galaxy?

For more information:
• http://www.nytimes.com/2010/07/29/arts/design/29nimoy.html  
• http://www.rmichelson.com/Artist_Pages/nimoy/pages/video.html  

Nichelle Nichols answers Fan Questions

When you think of an interview with a Star Trek legend the names Nimoy, 
Shatner and Stewart come to mind; their post-Trek activities are well known. But a 
two-part interview with another legend is worth a read as well. Nichelle Nichols 
answers question from fans at startrek.com on a variety of topics, from her talks with 
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J.J. Abrams and Zoe Saldana on the set of Star Trek (2009) to her resigning from The 
Orginal Series stopped only by Dr. Martin Luther King Jr. himself.

For the complete interview in two parts visit:
• http://startrek.com/article/nichelle-nichols-answers-fan-questions  
• http://startrek.com/article/nichelle-nichols-answers-fan-questions-part-2   

Christopher Lloyd Interview

Sci-Fi fans may remember him best as Doc Brown from Back to the Future, but 
real Trek fans will know him as Klingon Commander Kruge from Star Trek III. In a rare 
interview before Creation Entertainment’s Chicago Star Trek Convention Mr. Lloyd 
recounts the enduring popularity of his science fiction characters and speaks of 
current projects.

Catch the entire interview here:
• http://startrek.com/article/christopher-lloyd-interview   

These Ain’t No Space Westerns

Before Gene Roddenberry propelled our living rooms to the stars, the stars of 
the original series had more down to earth roles. In seven episodes from shows like 
Bonaza and Outlaws catch Spock, Kirk, McCoy and Scott before they began their 
Starfleet careers.

Saddle up cowboy and find out how you can wrangle up a copy:
• http://tvshowsondvd.com/news/Site-News-Trek-Stars-Go-West/14555  

Kicking the Sequel into High Warp

Though the next Star Trek film is still two years away, the writing team of 
Kurtzman, Orci and Lindelof are busy crafting the next chapter in the venerable 
franchise. They reached a milestone in the movie’s development by breaking the 
sequel’s story recently.

Read about how they deal with noise of the outside and more:
• http://www.nbcconnecticut.com/blogs/popcornbiz/Star-Trek-Sequel-Writers-  

Ready-to-Go-to-Warp-105364818.html
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So you want to fix the Enterprise yourself?

Are you the fix-it-yourself type? Are you a chief or budding engineer in 
Starfleet? Have you lost your three copies of the TNG Technical Manual? Your wait is 
finally over. Haynes, who produces multitudes of auto repair books, propels itself into 
the 24th century with the U.S.S. Enterprise Owners’ Workshop Manual. They cover the 
NX-01 up to the 1701-E in 160 pages of colorful glory. (Not available in Romulan or so 
aligned sectors.)

Order at:
• http://www.haynes.co.uk/webapp/wcs/stores/servlet/ProductDisplay?  

catalogId=10001&storeId=10001&productId=51713&langId=-1
• http://www.amazon.com/Star-Trek-U-S-S-Enterprise-  

Haynes/dp/1451621299/ref=sr_1_1?ie=UTF8&s=books&qid=1288152167&sr=8-1

Event Calendar

Upcoming Star Trek and Star Trek related conventions.

November 7, 2010 – Norwich Sci-Fi Festival, University of East Anglia, Norwich, England
November 12-14, 2010 – OryCon 32, Portland, Oregon, USA
November 13-14, 2010 – EXP-CON, Honolulu, Hawaii, USA
November 26-28, 2010 – Starbase Indy, Indianapolis, Indiana, USA
December 3, 2010 – FREE Sci-Fi Market Place, Honolulu, Hawaii, USA
December 4, 2010 – Official Star Trek Con, Honolulu, Hawaii, USA

[back to table of contents]
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Star Trek Online
by Captain Havraha cha'AAnikh

A lot of USF simmers have taken an interest in the latest Star Trek video game, 
Star Trek Online, including myself.  I’m the head of our guild inside the massively 
multiplayer online roleplaying game – if you’re interested in joining up with your 
character, IM me at USFHavraha on AIM, or catch me in game at 
Havraha@Havraha!  But enough of that, I’m here to tell you about the latest news 
pertaining to the game.  Certainly there’s a lot of news you could find on the website, 
but those people who listen carefully to even the tiniest mumblings and posts of the 
developers can catch the kind of information we catch here in STO News!  So without 
further ado...

Intel – New Releases

Nebula Class Starship Released
by Qaylan Furlong

The iconic Nebula Class of the late 24th century has been retrofitted to give it 
everything an Admiral needs to battle the Borg or face down a Breen armada! The 
Advanced Research Vessel Retrofit is a science vessel with six weapon slots (3 fore, 3 
aft), seats for five Bridge Officers (Lieutenant Tactical, Lt. Commander Engineering, 
Commander Science, Ensign Science and Lieutenant Universal), space for 8 console 
modifications (2 Tactical, 3 Engineering and 3 Science), 3 device slots, and a crew of 
750 officers. It also features Subsystem Targeting and a Tachyon Detection Grid that 
will increase Starship Sensors as well as Stealth Detection. When the grid is active, it 
also increases the Starship Sensors and Stealth Detection of all nearby allies. Those 
allies, in turn, can extend those benefits to allies near them, thereby extending the 
overall size of the grid. The Tachyon Detection Grid is not modified by Stats or Auxiliary 
Power.
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Note: This ship may only be purchased by Federation Rear Admirals. The Advanced Research Vessel 
Retrofit may be obtained in game per character by spending Marks of Exploration. Purchasing the ship 
from the C-Store unlocks it for all Rear Admiral characters on an account.

Sehlat Cub Released

When Star Trek Online and … moreso to the point, its sister-MMO Champions 
Online, hit the scene … it was promised that items that would be added to the C-
Store, Cryptic’s store for tiny microtransaction on additional content, would only offer 
things that were “fun”, and “goofy”.  The last thing anyone wanted was for the store 
to add items that gave players an advantage over people that chose NOT to pay 
additional money for the game.  Star Trek Online has kept pretty close to that initial 
view, but the things that have been added lately, like alien species and retrofitted 
ships, also have a very strong practical purpose to them that make them useful in the 
game. 

So it’s kind of funny to me that the C-
Store has, at least temporarily, re-
embraced its “totally useless item” mantra. 
A new item that harks back to that “entirely 
useless, but totally fun” mentalty the original 
items on the C-Store had is the Sehlat Cub 
Pet. –

As diehard trekkies are aware, sehlats 
are a wild and dangerous animal from the 
planet Vulcan that are often tamed by 
Vulcan children as pets.  The Sehlat Cub C-
Store item is a pet in all its glory – it offers no advantage on the field of combat.  It 
neither attacks enemies, nor does it even work like a Tribble and buff you temporarily 
– all it does it appear and follow you around in an utterly ridiculous and adorable 
fashion, and disappears as soon as combat starts.  It appears to be a slight reskin of 
the Klingon’s pet targ item which has been available since the game’s launch, but 
while the pet targ is exclusive to Klingons, the sehlat cub can be used by Federation 
characters and Klingons alike.  I named mine Cheeto, by the way.  The sehlat cub is 
available for 120 Cryptic Points.

Vor’cha Class Variant Costume Pack, the Tor’Kaht Class Released

It’s a simple fact that the Klingons haven’t gotten the same amount of love as 
the Feddies have when it comes to STO. Even though I don’t describe myself as being 
attached to the Klingon faction all that much (I do have a Gorn named Slakk), I do 
smile when I see new Klingon stuff added to the game, and this is one of them.  The 
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Vor’cha class is one of the most popular Klingon vessels, popular enough to warrant a 
refitted version for Tier 5 players. This Costume Pack adds the pieces for the new 
“Tor’Kaht” class variant as options to pick from on your Vor’cha class vessel, whether 
retrofitted or not.  And I don’t care who you are, that sucker is mean looking!  

The Tor’Kaht costume pack is available for use by Klingon characters only 
(obviously) on the C-Store for 160 Cryptic Points.

Intel – Missions & Content

The Return of Gozer and New Klingon Missions

The Cryptic Studios developer that goes by the forum handle “Gozer” has 
returned from a long hiatus.  What does that mean for Star Trek Online?  Quite a lot! 
Gozer’s job at Cryptic is “Content Designer” for STO, which means that it’s his job to 
come up with and build new mission types.  The return of Gozer means that the super-
hard, end-game missions known as the Special Task Force (or STF) missions will receive 
overhauls, particularly the mission “Terradome” which has received countless 
complaints for being nothing more than overwhelming players with enemies.  Tweets 
from Gozer’s Twitter account reveal other new things in the work for Klingons, such as 
–

“First new KDF mission type created, how many freighters can you disable and 
pillage before they all warp out to safety? J”

“Second New KDF mission type done …. J Time to go destroy Starfleet Ships in  
drydock for repairs J Muwahahahahaha”

“Hmmm… how about a daily KDF mission that lets you hijack a fed ship and 
cause havoc??? What do you guys think?”
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While in the forums, Gozer has mentioned that he is now reviewing ways to 
open up a previously Fed-Only Sectorblock in the game for Klingons to explore.  He 
plans to re-work several planetary systems and locations already there, but give a 
decidedly Klingon-twist to the missions.

All of these will be welcome additions to the Klingon Faction of STO, which is still 
widely criticized for lacking content that people want to play.

Introducing The Foundry – STO’s User Generated Content Engine!

MMORPG’s come in a lot of shapes and sizes.  Some of them are open-world 
games that entirely revolve around players running around, meeting up, and making 
their own destiny.  Titles like Second Life revolve around players joining up to build 
new levels and items in game.  Star Trek Online is a very story driven MMO, involving 
you making a Captain and joining friends as you play through the various missions 
and stories that lead through the Federation-Klingon War of 2409.  But what happens 
when two of these genres combine?  That’s precisely what’s happening now to Star 
Trek Online!

Ever since Dan Stahl (known by the handle "dstahl" on the forums) has taken 
over for Craig Zinkevich as Executive Producer of Star Trek Online, his primary goal has 
been to address faults players have found with the game – the most common fault 
being that “there’s simply not enough things to do!”  Very wisely, in my humble 
opinion, Stahl has concluded that it would take the developers too many resources 
to get the content level up to the level players want, and it would take too long to 
satisfy them to boot.  Hence, Cryptic has been working very hard on building what 
they’ve now decided to call “The Foundry”, a toolset that will be built into the game 
for the players themselves to be able to build their own missions, environments, and 
stories … and share and rate these creations throughout the universe. 
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This bold new move now puts Star Trek Online in a weird gray area of the MMO 
landscape – is it a story driven MMO, or is it a User Generated Content MMO?  Will it 
appeal only to Star Trek and space battle fans, or will it attract the same creative 
crowd that populates games like Minecraft?  Only time will tell, as the beta version of 
The Foundry will be introduced in the “Season 3 Update” for Star Trek Online due out 
sometime near December 2nd.  For those of you who absolute can’t wait, beta 
testing will be available sooner than that on the Test Shard, more formally known as 
the Tribble Test Server, sometime in November.  Until this, here are some screenshots 
of the toolset in action (seen above).

The Return of Episode Replay, and Confirmation on the Bridge Officer Alt

One bummer of Star Trek Online is that because it’s so story based, some of the 
best missions you can play are the story missions…. which … unfortunately … can’t be 
repeated once you’ve beaten them the first time.  The only way you could do it 
would be if you teamed up with another player who had the mission available, and 
he shared the mission with you.  Imagine my delight then, when at the launch of 
Season 2 the developers announced the Episode Replay function would be added 
to the game.  Also, imagine my frustration when it was revealed that Episode Replay, 
along with “sitting-in-chairs tech”, would be put on hold while development resources 
were piled into making the User Generated Content engine.  

Well now that The Foundry is nearly completed, development resources have 
been freed-up, and Episode Replay is now back on the development schedule.  Also 
confirmed in this is the Bridge Officer Alt;  an idea conceived by a player on the 
forums that the developers pounced on as genius – the ability to promote one of your 
bridge officer crew on one account, to Captain so you can play as him as another 
full fledged character.  So if you ever get attached to that science officer, or have an 
exclusive Breen bridge officer that you want to play as, your chance is coming!

Overhauls, and More KDF Content

Dan Stahl has hinted at several things coming down the pipe.  On the forums, 
he’s revealed his idea that –

“…includes a massive discussion about end game rewards and the economy 
which need an overhaul in my opinion.”

Interesting.  I’m not sure how he plans to overhaul end game rewards, or the 
economy for that matter, but I hope he doesn’t take Star Trek’s rather communistic 
approach to currency to heart.  It may be the way it works in the show, but it would 
never work in the confines of a player-driven economy MMO.

Going on, he touched on the crafting elements of the game which are found 
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on the planet Memory Alpha, and even more planned additions for Klingon content –
“And don't think I've forgotten about Memory Alpha because I haven't - that is  

going to be continuing to get love in upcoming updates. You'll also notice that  
Klingon patrol dailies (any level) are being added for Season 3 release, which  
coincides with allowing the KDF to craft items and gather anomalies (in their own  
special way).”

Well they’re certainly earning their subscription fees with all the updates they’ve 
been going off on this past month.  Heres’ to them!

Intel – Sneak Peeks

Non-Klingon Ships Coming to the Klingon Faction, and We’ve Got Pictures!

By the year 2409, the Klingon Empire has annexed several surrounding species 
as members, including the Nausicaans, the Orions, and the Gorn.   Although their 
clothing and technology has been with the NPCs forever, players have … however … 
been forced to wear strictly “Klingon” clothing and fly “Klingon” style ships.  All of this 
is being remedied, as Orions and Nausicaans have already received new species-
specific clothing options, and the Gorn options are on their way (see below), but 
some of the best news of all is the 
addition of 4 new vessels, 3 of 
them in the style of non-Klingon 
vessels, and we have pics to show 
them off! --

Lots of rumors are going off about these ships as well, including that the scary 
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Nausicaan spider-lookin-ship will feature a harpoon attack.  Wiiickkeedd!!  We’ll keep 
you updated as more comes out!

The Gorn are Getting More Than Clothes

I don’t nerd-rage much on the forums.  Despite the temper I’m known for in the 
USF, I usually keep a pretty level head when it comes to problems pertaining to STO. 
But I have to tell you, I about lost my mind in anger when Cryptic advertised “new 
non-Klingon clothing for Klingon faction characters!” and the Orion and Nausicaans 
got clothing, but NOTHING came in the way of new Gorn stuff.  Well, turns out that’s 
because they’re giving Gorn a 
little more attention than they did 
the others, and this test shot, 
released by one of the art devs on 
the forums, reveals an early model 
for a completely new skin option 
for the Gorn! –

Now this looks SHOCKINGLY 
different from the default Gorn, 
which looks extremely similar to the 
TOS Gorn, just with spikes on its 
head.  This new Gorn texture 
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option that’s in the works looks like a take on the American Godzilla movie, honestly, 
and I’m confused as to how they’re going to offer both of these looks in the game 
and state that they’re still the same species.  They look ENTIRELY different.  But alas, 
that’s what they plan to do.  The look may be drastically different by the time it hits 
the shelves, who knows.  More as more comes out.

NX Class Starship in the Works, and a Possible Contest to Design the Next Enterprise?

Cryptic’s very good about adding content to the C-Store when they can pitch 
it to CBS as making money. So when fans told them they’d pay for the chance to fly 
around in the ancient NX Class starship from Enterprise, Cryptic had no problem 
selling the idea to CBS.  

Here’s a test shot of the ship, released by a dev on the forums –

However, Cryptic did plan on also releasing the Enterprise-J vessel, only seen for 
a short second in an episode of Enterprise.  That’s not coming to fruition, because CBS 
changed its mind on letting players fly around in ships from THAT far in the future. 
However, Dan Stahl has announced plans to see if CBS would support and promote a 
contest for fans to make up for it – the contest would be to design a new class of 
starship from the near future, sometime between 2409 and the Enterprise-J, which 
would then be used as the next Starship Enterprise.  Nothing concrete has come out 
of CBS yet, but if this takes off, the winner of the contest will have designed an official, 
canon Star Trek vessel that will be added to Star Trek Online! And not just that, the 
next ENTERPRISE!  How cool is that!?
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Sexyprise Suits

Let’s face it – Star Trek isn’t Star Trek without the sexy.  From girls in short skirts on 
TOS, to not-so-shamelessly-implied love scenes in episodes, Trekkies love the sexies, 
and that’s been a ratings point for several of the series in the past.  Now STO is giving 
you the option to sexy up your officer by wearing two of the most iconic get ups ever 
seen in Star Trek.

1.) Seven of Nine Jumpsuit Released on the C-Store!

Fan of Voyager? Fan 
of big boo... brains? What 
better way to show it than 
laying down a few C-Store 
points on the 7 of 9 jumpsuit! 
The jumpsuit comes with 
Borgish face implant and 
hand-doohikey too! ... 
impressed with my 
terminology? You should be. 
I didn't spend years in the 
Academy for nothing! Now 
quit reading and gaze at 
those beautiful brains!

2.) T'Pol Uniform on the Way

Although 7 of 9's classic jumpsuit has already 
been released to the C-Store, those of the pointy-
earred persuation (or those who just like their fashion 
sense) will be able to don T'Pol's catsuit soon, too! 
Unfortunately it's her uniform from the later series, and 
not the much more skin-tight early series outfit that I 
prefer, but hey ... beggars can't be choosers, right? 
Check out this picture released to the forums for a 
sneak peek!

[back to table of contents]
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Potentially Habitable Planet Discovered

In a news article featured on NASA's website on September 29, 2010, it was 
reported that a team of planet hunters announced the discovery of a potentially 
habitable planet in a nearby star system called Gliese 581. The team has been 
observing the red dwarf system in the constellation Libra for some 11 years, collecting 
data via precision radial velocities. Their observations indicate six planets orbiting the 
system's sun, though only the last one, GJ 581g, lies squarely within the habitable zone 
of the star. It has a minimum mass of 3.1 times that of our Earth and an orbital period 
of 36.6 days.

For more information:
• NASA article - 

http://www.nasa.gov/topics/universe/features/gliese_581_feature.html
• Original paper in the Astrophysics Journal - 

http://search.arxiv.org:8081/paper.jsp?
r=1009.5733&qid=12860566731899a_nCnN_1401828043&qs=compelling+case+g
liese 

Icy Tsunamis

On October 6, 2010, National Geographic magazine published a news article 
about a discovery that might solve a mystery that has puzzled scientists for some 30 
years. Current observations have found that the gravitational pull of Saturn's largest 
moon, Titan, seems to be causing enormous tsunami-like waves in the ice particles of 
its inner C ring. The waves apparently are in resonance with the moon, moving at the 
same speed, and so large that they at times block the view to the inner ring. 
Speculations of this phenomena had first been made after pictures taken of Saturn's 
rings were contradictory, at times showing a large gap and at other times not.

For more information:
• National Geographic article - 

http://news.nationalgeographic.com/news/2010/10/101007-saturn-rings-titan-
tsunamis-space-science-nicholson-nasa/ 

[back to table of contents]
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USF Features

Progress: 
United Space Federation's Website
a collaborative article by
Commander Loriarra and Cadet Malachi Styles

Visualization has always been a major part of story telling, from simple cave 
drawings and rituals dances, through eloquently descriptive novels and engaging 
theatrical performances, to monumental movies with ever inceasing graphic effects. 
Creative minds have long made use of what we see, hear and read to draw our 
attention and fire the imagination. At USF we all are creative minds!

Simming is quite a different medium than simply playing an electronic game. 
Instead of taking on the predetermined role set up by the game developers, we 
choose our own. We breathe life into something that has not existed before. 
Something unique to us. Our character(s).  

We create background information, plot out intricate story lines to develop our 
characters in more detail, and interact with others in an imaginary world of our 
making. All of that calls for the ability to help others visualize who this fictional person 
is and what the environment looks like in which the character lives. For that purpose 
we gather information in biographies, personal and duty logs, simulation logs, and 
other data files on the USF website's message boards, making it readily available to 
our fellow simmers.

From its humble beginnings - sector001.com, created in 1997 by Admiral 
Clements, followed by usf.for.net (later changed to core.sector001.com), created 
around 2001-2002 by Ambassador Arronax with the help of Captain Quixar - the USF 
website has come quite a way. Noticeable, it does not rely on cookie-cutter website 
layouts but uses a customized format that has transformed with time to reflect more 
functionality and ease of use. Particularly 
in the last few years, several updates, 
improvements, and additions have been 
made; the most recent of which is the 
Character Stats page.

Not long before the release of this 
latest upgrade, one of our correspondents 
had the chance to talk about website 
progress with our webmaster who, like 
many of us, volunteers his time and efforts 
in behalf of the USF.
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Interview with Vice Admiral Jonathan Anders
by Malachi Styles

Behind every quality computer site, is (hopefully) a quality webmaster.  In the 
case of the USF, quality easily describes our webmaster.  In my interview today, I was 
able to tackle Vice Admiral Anders and ask him some questions about the Core, and 
its future.

VAdm_Anders: ::nods:: Can we sit down for this or is it one of those hard-hitting stand 
up interviews?
CadetStyles: Well, Admiral. You have been in charge of the Core for how long now?
CadetStyles: And yes, please have a seat.
CadetStyles: ::indicates the nice comfy chair.:
VAdm_Anders: Mr. Styles, I've been dabbling with the Core for... well, since 2004, I 
believe it was.
CadetStyles: That is over a half a decade, sir. In the past couple of years, what would 
you say have been the more important changes to the core, for the USF members?
VAdm_Anders: ::leans back:: I think My Sims 
page is easily the biggest addition and 
probably the most important -- centralizing 
the information for each sim in one easy to 
access location.

Some others might include better 
management of characters and automated 
crew email lists.  And finally, I think the 
Webchat, including M-5 Bot, were huge 
additions to the USF Core.

Finally, perhaps more transparent but still 
important, was the message boards (a true 
change and not an addition) where 
navigation and accessibility were greatly 
improved.
CadetStyles: What was your inspiration for the 
"My Sims" page?
VAdm_Anders: Heh ::laughs:: completely selfish 
-- I hated having to manage a roster and also 
manage characters on the Core.  As 
Commanding Officer of Excelsior it seemed 
better to put it all in one place.  (And it 
seemed silly to not share it with everyone)
CadetStyles: ::Nods and chuckles:: I do agree that the MySims page has become 
quite useful. So, what other improvements do you foresee for the Core?
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VAdm_Anders: I'd like to see even better character information, to help inspire and 
provide information more quickly.  I'd also love to see the ability to look up a sim 
timeline, see all the logs of a single character or even (eventually) a message board 
search.   

I'd like to have an AIM Bot where USF 
members could quickly look-up Memory-
Alpha & Memory-Beta articles, even while 
they're simming, or other USF Characters.

The USF AIM Bot is actually in beta 
testing right now, members are free to give it 
a try though it may not be completely stable 
yet.  The readers can just try giving Screen 
Name USFCore an IM and try it out for 
yourself.
CadetStyles: An AIM bot for the Core seems 
quite an endeavor. Do you envision it becoming a reality in 2011?
VAdm_Anders: Absolutely, and I think it will be a great addition to not just USF but 
anyone who sims.  If you are already on AIM and you need to know what a 
transphasic warp drive is, you can just have USFCore bot look it up and IM you the 
answer in a flash.   

No opening a new browser window.
CadetStyles: Now for our readers, would you like to mention the one true stipulation 
for using the USF Core bot?
VAdm_Anders: Absolutely -- no hurting its feelings.
CadetStyles: ::Chuckles:: Not quite the one I was referring to, though it is a good 
point.
VAdm_Anders: One thing that will really hurt its feelings is not adding it to your Buddy 
List.  Because it can only send IMs to people who add USFCore to their Buddy List, 
since it is a Bot program.
CadetStyles: So, readers, make certain to add USF Core to your buddy list.

In closing, Admiral, I would like to thank you for your hard work and dedication 
to the USF. I know, personally, what you do is not always easy. Is there any parting 
words of wisdom for our readers, concerning the Core?
VAdm_Anders: Absolutely -- please complain.

My very first improvement to the USF Core system was actually fixing a persistent 
annoyance I always had. It was small but the change really helped me.  If USF 
members have issues, especially the small ones, speak up.  Use the feedback option 
and let me know.   

The Core has really evolved with many small changes to make it better -- so I 
hope I get more complaints, more suggestions and more "could we...?" messages.
VAdm_Anders: ::smiles::
CadetStyles: ::returns the smile:: Excellent, sir. Thank you for taking time out to talk to 
our readers.
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VAdm_Anders: My pleasure, Cadet Styles.

And there you have it.  A quick interview with the talented man in charge of 
the Core.  He wants no spotlights on himself, but I can tell you this:  He works hard to 
make your (and my) simming experiencing that much enjoyable.  

I, for one, say: "Thank you for your time, Admiral."

[back to table of contents]

Chatroom Choices – IRC vs. AOL/AIM
a collaborative article by
Commander Loriarra and First Lieutenant Solik

Edited excerpt from a SS Nigala sim:
drsolik (10:52:26 PM): One last thing...
mhiatrrrhiol (10:52:36 PM): ::raises brow::
drsolik (10:52:44 PM): ::moves closer to her and kisses her lightly on her lips:: 
mhiatrrrhiol (10:53:18 PM): ::is totally surprised, but not unpleasantly::
drsolik (10:54:11 PM): ::backs away slowly:: Thank you...for everything, Mhia. Good luck. ::slowly 
backs out of the shuttle::
mhiatrrrhiol (10:54:43 PM): ::still a bit stunned, slowly sits, looking out the hatch at him:: Jolan'tru... 
Solik.
drsolik (10:55:22 PM): ::nods with a smile and closes the hatch once he's out::
mhiatrrrhiol (10:55:39 PM): ::sighs heavily, and finally turns to the LCARS panel and the task at hand::
drsolik (10:56:15 PM): ::walks to the door and opens the outer door::
mhiatrrrhiol (10:56:28 PM): ::takes the shuttle out of the bay and into space::
drsolik (10:56:54 PM): ::closes the outer door as a single tear drips down his face::

The use of chatrooms is essential for live simulation role-playing games like the 
ones the United Space Federation provides. For the most part, sims take place in 
AOL/AIM chatrooms, but from the time the USS Lexington came into existence, USF 
has also tried to cater to those that are either unwilling or unable to make use of 
AOL/AIM chatrooms by widening out into the realm of Internet Relay Chat, also 
known simply as "IRC".

Though both mediums are used for group communication, there are several 
differences which lead people to choose one over the other. First, one of the main 
dissimilarities is that in order to use AOL/AIM chatrooms, you must download the AOL 
internet browser or the AIM chat client, or a compatible third-party chat program like 
Pidgin or Trillian; while in order to use IRC channels, you must be able to access the 
internet and know the URL of a desired chatroom. Second, both mediums require you 
to log in, one way or another, but AOL/AIM requires you to create a unique, 
password-protected user name which cannot be changed, while IRC offers the 
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creation of a user name which can be registered with a password but is changeable 
at any time.

There are also some similarities. One, for example, is the ability to eject those 
that are being disruptive from the chatroom; though even that is handled slightly 
different in both mediums. In AOL's public chatrooms an AOL member can take room 
ownership if they are first in the room. This will allow them to eject anyone coming in 
after them. In IRC chatrooms those with specific modes, such as operators and 
higher, can eject and even ban others as long as they are equal or below their level 
of mode. This function does not depend on when one enters the chatroom.

The Lexington mentioned previously eventually began simming in an AOL/AIM 
chatroom, but issues that developed with AIM Screen Names having trouble entering 
or staying in those rooms caused the USF's webmaster to look into alternatives to that 
medium, which led him to Mibbit.com, a web-based chat interface that uses the IRC 
protocol. In time, the Sector001 webchat room was set up and officially put into 
service on May 11, 2009. A couple of month later, the M-5 bot was added to 
enhance the channel's overall functionality.

M-5's specialized features not only enhance the usability of Sector001's 
webchat room, but his interactive properties make it a lot more fun as well. Aside 
from his quick-witted humor and sometimes downright sassy responses when 
addressed, M-5 also provides the ability to look up information on such things as 
Memory Alpha and Beta articles, "Lexicon" articles, various data on the core 
pertaining to crew members, logs, and briefings, dictionary inquiries, and much 
more.*

For simming purposes, M-5 supports a sim logging function, as well as a minisim 
logging function for writing Joint Logs, which are both then made available on the 
core. Finally, there are also numerous simming-specific alias commands based on 
already existing Mibbit commands that make situations such as Red Alerts much 
more "colorful".

* As mentioned in the previous article, the AIM bot, USFCore, mimics some of these functions and is  
currently in beta testing. Don't forget to try it out and give the webmaster feedback on it!
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Now that USF members had a chance to use the webchat room for over a year 
- which includes four sims that permanently started simming in various channels set up 
in connections with the main chatroom - we ran a poll to see which medium, IRC or 
AOL/AIM, was preferred by simmers.

Out of the 19 people that gave us responses to the poll - all of which have used 
or are currently using both IRC and AOL/AIM for simming - 13 preferred the Sector001 
IRC-based webchat room and six the AOL/AIM chatrooms.

A specific reason cited for favoring IRC over AOL/AIM is the preference of using 
the aforementioned alias commands. One of those polled stated they "like the room 
commands, like /axn and /ra** which are not available with AIM". Another mentioned 
that "with AIM I gotta download their software" and "it's loaded with ... ads". It was 
also noted as a positive that one does not have to created a specific, password-
protected Screen Name, but "just click the webchat link on the USF page" and type in 
a desired name, which makes "rank changes super easy". "More versatile, more 
stable", "easier to show emotions", and "by far, a lot cooler looking" were a few other 
reasons those who prefer IRC indicated for their choice.

A universal response from those that prefer AOL/AIM over IRC was "familiarity". 
One of those polled noted that they "rarely have problems staying logged in on AIM 
chat room, but have issues staying logged in on the IRC room at times", which was 
echoed by another one mentioning that the Sector001 IRC "chat room doesn't play 
nice with Internet Explorer and even gives ... trouble with Mozilla sometimes". "Ease of 
use, private logging function, more customization options", and "easier to manage 
multiple characters" were some other reasons cited by those favoring AOL/AIM.

As noted at the outset, most of USF sims take place in AOL/AIM chatrooms, but 
despite the Sector001 IRC room being comparably new, it is continuously evolving. 
We, the authors of this article, can only echo the words of one of those polled when 
they said that they "appreciate the efforts of all involved with working to make (the 
Sector001 webchat room) user friendly and USF friendly". 

All in all, there were those who were very detailed and clear about why they 
made their choice for either, while others had rather simple reasons for their 
preference. Either way, the USF has both mediums available for simming. If you 
haven't tried one of them, as they say, there is no better time than the present!

** /ra is the alias command for initiating Red Alert
Note: Thanks goes to Fst. Lt. Adrenna Darz for helping with gathering the information.

For all those out there that are thinking of trying out simming, the United Space Federation has 
choices, whichever one of the two chat mediums you prefer. - Come try it out!!

[back to table of contents]
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The Worlds of Havraha
a collaborative article by
Cadet Malachi Styles and First Lieutenant Leyva Torosi

In every galaxy there are some stars that shine brighter than others.  Recently, 
the USF PADD had the chance to have a chat with one of our very own bright stars: 
Captain Havraha cha'AAnikh, currently the commanding officer of the USS Ares. 
Captain Havraha, also called Hav, has been simming with the USF for many years. 
Along with his discovery of simming, Hav also discovered a talent for creating 
computer graphics—several of them in the form of planets—and has been honing his 
skills creating those and other interesting graphics for quite some time.

So without further delay, let's hear from Captain Havraha himself as he answers 
the USF PADD's questions and offers his insight into his "worlds"....

USF PADD: I'll get right to it then! Can you start by telling us a little bit about your history 
with the USF for the benefit of those who may not have had the privilege of meeting 
or simming with you?
USFHavraha: Oh wow. Uhh ... you know, I can't tell you how long I've been simming 
with the USF. Through most of my teenage years, I suspect. I found the site by 
searching for "Romulan Names" on Google and being brought to the Sector001 
website where I started a character who was a Romulan named "Carnin" on the 
Lothlorien. Over time and after a name change, I've become Captain Havraha of 
the USS Ares.
USF PADD: That's actually pretty interesting!  Most of our questions are in regards to 
your graphics.
USFHavraha: Ah, right.
USF PADD: How long have you been working with graphics and what got you started?
USFHavraha: Years upon years. Shortly after I moved from the Lothlorien to the USS 
Federation, I met a simmer there with the character Jen Lee Ciani who was good 
friends with Captain Quixar. Quixar was teaching Ciani how to use Corel Paint Shop 
Pro and, hence, Ciani gave the program to me. I started playing with it and then 
when Quixar started going to school for graphic design, he started using Photoshop 
exclusively so I too switched to Photoshop. I think it was at that point where I made 
some space artwork in Photoshop by following a tutorial I found online and when 
Quixar saw it, he stuck a starship in the picture with it. I was absolutely floored by how 
realistic it looked, and I was hooked. I knew that THIS was what I wanted to do.
USF PADD: So do you create your graphics exclusively in Photoshop or do you use 
other programs?
USFHavraha: At this point, most of the heavy lifting people see in graphics I use is 
done almost entirely within Photoshop CS5. However, I do use Photoshop's sister 
program, Illustrator, when I'm inking line art.  I'm also proficient in a couple of other 
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Adobe programs that don't directly result in graphics. However, I'm also teaching 
myself how to use GIMP so I can include that program in the new USF Photoshop 
Tutorials.
USF PADD: Oh? That's the first I have heard about USF Photoshop Tutorials. Is that 
something you are working on for the site?
USFHavraha: USF Photoshop Tutorials is an article series that will be featured in the 
PADD.
USF PADD: Oh that's excellent, I am sure a lot of people will be interested in learning 
from your expertise! I for one!
USF PADD: You have been pretty ..... vocal about GIMP in the past. Why use it now?
USFHavraha: Vocal about GIMP is an understatement. Honestly, I absolutely despise 
GIMP as a program, but many people who want to do graphics work simply can't get 
Photoshop.  So I use it to make the article series more pertinent to people who would 
rather use a free program.
USF PADD: That's a very good point since Photoshop is pricey.
USFHavraha: Yep.
USF PADD: What types of subject matter do you prefer to work with in your graphics?
USFHavraha: My favorite thing to do is bio images, meaning pictures of people's 
characters, which they then send out in email along with their bio. There's something 
very fun about bringing a character to "life" so they're no longer just text on a screen. 
Beyond that, in recent months and years, I've gotten interested in making planets 
using Photoshop.
USF PADD: What advice would you give to someone who wants to "create" their own 
bio-picture?
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USFHavraha: My main advice is to toy with the program and learn what each tool 
can do. Also, don't be afraid of layers. I was when I first started but, honestly, they're 
your best friend.
USFHavraha: Okay, well in these pictures, you can see a bit of an evolution in how I 
created planets.
USF PADD: To someone like me they actually all look pretty amazing. What steps did 
you take to refine your skills?

USFHavraha: The first planet shown is very much possibly the first planet I ever made... 
it's Vulcan, and you can see it on the Lexicon's page for the planet. At this point I was 
following a very fantastical tutorial that made stars look a little bit too good to be real. 
I was also using filters to make all the land and water, and I was painting clouds into 
existence with a brush.

The steps I took were, essentially, get better equipment and find better 
methods to achieve what I'm trying to do.  In the second picture, I'm trying new things 
like rings and whatnot and I'm trying to make the planets larger.

In the third image, I reached what I call the "apex" of my fantasy planet phase 
where I was using a second texture rendering program to make the surface of the 
planet and I was going in and painting all the little city lights on the planet in the dark 
zones. 

The fourth planet is my most recent planet. I tried to move to a more realistic 
approach to planets. I studied pictures of Earth to see what made them look "real" 
and then adjusted what I was doing accordingly. I also started using cloud maps for 
the clouds instead of painting them by hand which increased the realism by a lot.
USF PADD: I was going to ask if you had a favorite tutorial or resource but you've 
already told us you're developing a series of tutorials. Will the first one be ready for this 
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issue of the USF PADD?
USFHavraha: Yes. And it'll be on the topic of the basics of making planets in 
Photoshop and GIMP. Readers ought to be able to scroll through this PADD now and 
find it. But if others are wanting a head start, I recommend they visit the USF PADD's 
archives. The most recent additions will have the original USF Photoshop Tutorial series 
at the end of each edition of the PADD.
USF PADD: Excellent!  Do you have anything you'd like to add before we wrap it up?
USFHavraha: Just a plead that if anyone would like to submit questions about 
Photoshop or GIMP, email me at Havraha@sector001.com and they'll be addressed in 
the next edition of the USF Photoshop Tutorials!
USF PADD: Excellent.  Thank you very much for the information.
USFHavraha: No prob!
USF PADD: I appreciate you giving your time for the interview and look forward to 
seeing your tutorials!

[back to table of contents]

Dream Job
by First Lieutenant Leyva Torosi

Currently simming with the USS Excelsior as Lieutenant J.G. Vivien Valdore, Kelly 
Rowles has been with the USF since 1996. Her most well-known persona is probably 
Captain Lyra Rose of Starbase Everest, but among various other guises she may also 
be recognized as Candace Darign Glack, one of her first characters, who served on 
the Eclipse, Roddenberry, Lothlorien and with Outpost Phoenix. 

A lifelong Trek fan, Kelly has recently written an article (“How Star Trek Changed 
My Life: Kelly Rowles”) that is being featured on StarTrek.com, detailing how her love 
of Star Trek and her experiences with the USF have influenced her life. One of the 
most fascinating aspects of her story is how she has parlayed her experiences into a 
part time job that is sure to be the envy of many a fan. And while the pay for her 
efforts is modest, the rewards are great - Kelly works as a member of the press who 
goes to various conventions reviewing them, plus she gets to interview convention 
guests – including Star Trek stars! 

I have recently caught up with Kelly and chatted with her a bit regarding her 
gig as a representative of the press. 

Torosi: Attending and reviewing conventions and getting the opportunity to 
meet/interview Star Trek actors could be described as a Star Trek fans dream job. 
Exactly how did you make the transition from being just a fan to making money doing 
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this? 
Rowles: Well, I should preface this by saying there is virtually 
no money in it. You sometimes get in for free, and there's a 
certain monetary value there. But mostly it's pocket 
change. 

As for the transition, I started writing a conventions 
blog for a site that was paying $1 a post plus traffic. I had 
some articles get picked up by some big geek news sites, 
and my traffic exploded. I started getting recognition, and 
started getting invites to conventions. Other sites started 
asking me to contribute to their sites as well. I started 
moving up the ranks and doing editing for them too. The 
bigger the site, the bigger the convention, the greater the 
access to the celebs. It's taken about two and a half years 
to finally get to here. 

I'm now the managing editor of Voyages magazine, the official magazine of 
the International Federation of Trekkers. Hopefully it just keeps getting better! 
Torosi: I am sure it will! What is your favorite part of this gig? 
Rowles: Oh, that's a hard one. I mean, getting to interview and talk to these actors, 
people I grew up watching on TV every day is so incredibly cool. But an even better 
feeling is when someone comes up to me at a convention and recognizes me, and 
tells me they read my blog every day. 
Torosi: Yes, I imagine that would be wonderful to know that you've become a Star 
Trek celebrity in your own right.
Rowles: Heh. I wouldn't say a celebrity. But an recognized individual in fandom 
perhaps, heh. 
Torosi: That's a good description And on the same topic, what is your least favorite 
aspect of the job? 
Rowles: I wouldn't say "least favorite" but perhaps, "most disappointing" is when a 
celeb guest turns out to be not so friendly. 
Torosi: Ooooh.... 
Rowles: I try not to idolize. I also recognize people have off days. But when someone is 
consistently not friendly, it can be really disappointing. And there are some celebs 
who just don't seem like they enjoy cons anymore, and it shows. Not gonna name 
names though! 
Torosi: LOL  I've heard that conventions in general, Star Trek conventions included, are 
on the decline. Have you found that to be the case? 
Rowles: Well, yes and no. There have been a few major convention collapses that 
made the news and even resulted in charges of fraud against the organizers, the 
most well known of which is JumpCon. So fans and celebs are being extra careful 
with new and small conventions these days as a result. 

On the other hand, Creation Entertainment has dozens of convention each 
year, and is even going to new cities. I see cons like Shore Leave in Baltimore with 
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attendance caps in place. I see Creation cons selling out still. Not all of them do, but 
they are obviously turning some kind of profit. What I am seeing less of are cons that 
are Star Trek only. Most Trek cons have branched out to involve Stargate, Battlestar 
Galactica, etc. That is a survival mechanism for sure, and I think it has helped keep 
some in business that might have otherwise faltered. 
Torosi: And I'd venture to guess that there is a lot of cross-over in the fans of those 
series....making it a more fulfilling experience for all. 
Rowles: Exactly. Rather than hold a Stargate con and a Trek con, you hold one 
general sci-fi con and get one guest from each show your fans are there for. Shore 
Leave has done a good job with that, as has Farpoint. 
Torosi: If a Star Trek fan could only make ONE convention a year...which would you 
recommend they attend? 
Rowles: Oooo. That's tough. I can't pick one, but I can offer a top selection. Creation's 
Vegas con is certainly the place where you can meet the most Trek celebs in one 
place, so that has to be on the list. Another con that is a must-see for 2011 is TrekTrax 
Atlanta. It has a full programming track for all things Klingon, which is just cool. Plus, it's 
run by Eric Watts, who did Trek programming for Dragon*Con for 17 years. 

And finally, there's Dragon*Con. They usually get close to a dozen Trek guests 
per year. But they also have 30+ other genre programming tracks and some 400+ 
celeb guests. You just can't go wrong with Dragon*Con. How's that for a long winded 
avoidance of your question? 
Torosi: Actually it's a great answer thank you! Which of the Star Trek series is dearest to 
your heart? And which character do you like the most? 
Rowles: Oh I am a huge Deep Space Nine fan. I love that show like no other. As for 
favorite character, that is so hard. I love Martok. I love J.G. Hertzler, who plays him. I 
also think Marc Alaimo (Gul Dukat) and Jeffrey Combs (Weyoun) are so incredibly 
talented, and their characters were so good. And Garak. That's a top four for you. 
Torosi: I'm going to wrap up by asking if you have a favorite story you'd like to share 
about meeting any of the Star Trek stars or about something interesting/funny that 
happened to you at a convention? 
Rowles: Hmm. I have a lot of stories, but I will say that there are a few actors who left 
a wonderfully positive impression on me. George Takei, Cirroc Lofton, Avery Brooks, 
Wil Wheaton, and Garrett Wang are all incredibly nice. 
Rowles: Oh wait! I do have a story. And I can give you 
a killer photo to go with it. 
Torosi: Oh wonderful! 
Rowles: Okay, so it's the DS9 panel at Dragon*Con. It's 
Rene Auberjonois, Armin Shimerman, Avery Brooks, 
J.G. Hertzler, and Robert O'Reilly. And this little kid 
comes up to the mic to ask a question, and Avery 
insists the kid come on stage, sit on his lap, and say it 
into HIS mic. Adorable. I don't even remember what 
the kid asked. 

So, the next person to ask a question is a guy in 
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his 20s. And he tells them he's kinda jealous of the kid before him. And J.G. tells the 
guy to come sit in HIS lap. And everyone laughs. And then J.G. insists. So... reluctantly, 
this 20-something goes up there, and sits in J.G.'s lap. 
Torosi: ROFL! 
Rowles: And then Robert starts rubbing his shoulders. 
And then Armin jumps in Rene's lap.  And Avery is just 
dying with laughter. That just goes to show you how 
crazy and funny J.G. is. Avery is sweet. J.G. is a riot.
Torosi: That's terrific! Do you have anything that you'd 
like to add? 
Rowles: Final thoughts... I guess for those who maybe 
have never gone to a convention, I really encourage 
them to go to one. Start with a small local con if you 
can. You get to meet so many wonderful fans and people involved in the shows. 
Torosi: Thank you very much for taking the time for this interview. 

[back to table of contents]
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Science & Technology

Too Close for Comfort?
by Lieutenant Yahleksi Ra-Teahguay

“Those Asteroids that hit this morning – those were nothing – the size of  
basketballs and Volkswagons. This new one we’re tracking is the size of Texas,  
Mr. President. It's what we call a Global Killer – the end of mankind. Half the  
world will be incinerated by the heat blast, the rest will freeze to death in a  
nuclear winter. Basically, the worst parts of the Bible!” – A quote from the movie 
Armageddon.

September 8, 2010 - Two asteroids passed within 
the distance from the Earth to the Moon. Neither of 
these hurtling space rocks were even detected until 
just three days before their closest approach to the 
Earth.

Is the Earth safe? Or is it in the crosshairs of a 
cosmic world killer? Would we even know it was 
coming?

When questioned on how often something like that event occurs, Lindley 
Johnson, a program executive of the Near-Earth Object program at the United 
States’ National Aeronautics and Space Administration (NASA) said, “This is the first 
time we’ve seen (two) combined within a 24-hour period, but that’s probably 
because we don’t know everything that’s out there.” He went on to say that single 
asteroids have been known to make such close passes. He even said an occurrence 
like this might happen every day, and that they usually go completely undetected!

NASA has estimated that there are upwards of 50 million unknown asteroids. 
That’s 50,000,000 pieces of rock and metal hurtling through space with any one of 
them on a collision course with Earth!

Background

Ever since the earliest Humans first gazed skyward at the twinkling fires in the 
night sky, mankind has been fascinated with the heavens. They saw patterns in their 
groupings and named them after various gods and heroes and called the groupings 
“constellations”.

36

An Asteroid near Earth



When attentive sky-watchers began to note that 
the lights moved over time they began charting 
their paths. Most moved slowly in a circling pattern 
around the North Star that matched the seasons 
and the year. They noted how their sky-gods moved 
and called the path the “zodiac”.

Some of the sky lights they found weaving 
complex zig-zag patterns across the heavens. These 
they deemed “wanderers”. It was many centuries 
before they learned these were the other planets 
that orbited their own sun and that their apparent 
“wandering” was merely due to the visual shift 
caused by the fact they were viewing them from 

their Earth-based perspective.
But of all the night-time lights in the sky, it was the “shooting star” that brought 

the most awe. These fast-moving projectiles in the sky streaked across the heavens in 
real-time, leaving a brilliant streak of fire behind them like the lightning bolts thrown 
from the hands of the gods themselves!

As mankind evolved and his technology improved, Humans learned about the 
various bodies that orbit their Sun. The planets were charted and observed with 
powerful telescopes and later with space probes that floated past or even landed, 
exploring the surface of the planet.

They also began to turn their attention to the “shooting stars”. Tiny hunks of 
rock, metal, and ice, these comets and asteroids were hard to locate due to their 
diminutive nature and their extreme distance from Earth. At first, they discovered a 
band of asteroids clustered between the orbits of Mars and Jupiter. They named the 
region “The Asteroid Belt” and felt safe that all those random pieces of space debris 
were far from their home.

They tracked many comets and found that most hurtled past the sun and 
returned to regions far beyond the distant proto-planet of Pluto. They named this 
distant home of dirty snowballs “The Oort Cloud” and shrugged them off as 
occasional interlopers into the Inner Solar System.

But their technology continued to improve, enabling them to put their 
telescopes in orbit, beyond the blurring affect of the atmosphere itself. These new 
eyes in the sky brought them unsettling news: there were objects hurtling through 
space much closer than they’d ever imagined.

Near Earth Objects

As mankind’s technology advanced and they began to explore space, various 
governments instituted agencies to conduct their exploration and to catalog their 
observations. One such agency instituted by the United States of America is the 
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National Aeronautics and Space Administration (NASA).
As NASA’s abilities to explore and observe grew, they began tracking asteroids 

and comets that came close to the orbit of the Earth. They coined a new term, “Near 
Earth Objects” (NEOs) which they used to describe any space object that passed 
within a distance of 1.4 Astronomical Units (AU). One AU is the nominal distance from 
the Sun to the Earth, about 150 million km (about 93 million miles, or around eight Light 
Minutes).

The Spaceguard Report
In 1992, the United States Congress ordered a 

study called the “Spaceguard Survey Report”. This 
report focused primarily on impact risks of asteroids 
and how to address such risks. In the executive 
summary, the report stated: “Although the annual 
probability of the Earth being struck by a large 
asteroid or comet is extremely small, the 
consequences of such a collision are so catastrophic 
that it is prudent to assess the nature of the threat and 
prepare to deal with it.”

Having stated that the potential damage 
would be “catastrophic”, the report concluded with, “As a first step toward significant 
reduction of this hazard, we need to identify potential asteroidal impactors larger 
than 1 km (about 2/3 mile) diameter. In addition, attention should be given to the 
inherently more difficult problem of surveying as many potential ‘new’ cometary 
impactors of similar equivalent energy as is practical.”

This report eventually led to a congressional mandate for NASA to locate at 
least 90% of any large NEOs within 10 years of that date. Several other countries 
joined in the search, eventually forming the International Spaceguard Foundation 
(and other groups).

Discovered NEOs
As of September 6, 2010, NASA and the other members of the International 

Spaceguard Foundation had discovered 7,251 NEOs with a diameter of 1 km or 
larger. Of that number, 1,137 have been classified as Potentially Hazardous Asteroids 
(PHAs).

These PHAs are defined by measuring the asteroid’s potential of making a close 
approach to the Earth itself. A close approach is further defined as within 0.05 AU (a 
little more than 4.5 million miles). They must also have a diameter above 150 m (500 
ft.).

Each detected PHA is carefully studied and observed so that its calculated 
orbit can be further refined. Usually this refinement ends up removing the asteroid 
from the PHA list as it is discovered that its orbit is beyond the “close approach” limit 
or its diameter falls below the size limit.
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Close Approaches

Even with professional astronomers and amateur sky-watchers from all over the 
world peering into the sky with all sorts of telescopes, from small optical lenses to 
massive radio and X-Ray observatories, many NEOs go by every day undetected.

NASA says that every 100 years, on average, an asteroid of 50 m (150 ft) 
diameter would be “expected to reach the Earth’s surface and cause local disasters 
or produce the tidal waves that can inundate low lying coastal areas.” NASA’s History 
Office stated: “Meteorites the size of a basketball strike Earth about once a month, 
with nearly 75 percent landing in water.”

NASA also says that every few hundred thousand years an asteroid of 1 km (0.6 
mi) “could cause global disasters”. They say that if that were to happen, “the impact 
debris would spread throughout the Earth's atmosphere so that plant life would suffer 
from acid rain, partial blocking of sunlight, and from the firestorms resulting from 
heated impact debris raining back down upon the Earth's surface.”

Historical Impacts
It is now widely accepted that an asteroid possibly 10 km (6 mi) wide impacted 

the Earth in the Yucatan Peninsula some 65 million years ago and eventually caused 
the Mass Extinction Event that wiped out the dinosaurs.

The famous Barringer Meteor Crater near Winslow, 
Arizona (one of the best preserved impact craters in the 
world), was formed some 50,000 years ago when a mostly 
iron asteroid about 50m (160 ft) wide crashed into the 
planet. The crater is 1.2 km (0.75 mi) in diameter and 175 m 
(575 ft) deep.

In 1490 in Chiling-yang China, an estimated 10,000 
people were killed when an asteroid exploded overhead.

On May 14, 1864, some 20 stones fell out of the sky over Orgueil in southern 
France, covering an area of over a half-dozen square kilometers (several square 
miles).

In 1908 over Tunguska, Siberia, an asteroid estimated 
to be only 50 m (160 ft) across exploded in the air before 
striking the Earth. The force of the explosion has been 
estimated at 20-40 
megatons of energy and 
created a fire that burned 
for weeks. It leveled over 
2,000 square kilometers (770 
sq. mi.) of forest. Fortunately, 
this part of the world is 
sparsely inhabited and no 
people were killed.
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Recent Near Misses
On March 23, 1989, an asteroid with a diameter of nearly 0.5 km (0.3 mi) passed 

within 690,000 km (430,000 mi) of the Earth. It was not detected until AFTER it had 
passed its closest point to the Earth, and even then only after its orbital path was 
calculated backwards did they know how close it had come.

On October 8, 2008, an asteroid likely to have been about 10 m (30 ft) in 
diameter entered the Earth’s atmosphere over Indonesia. It eventually detonated in 
the atmosphere with an explosion equal to about 50 kilotons of TNT. The blast was 
visible even during the daylight hours and was recorded by the local media.

In November of 2009, an asteroid, only about 7 m (23 ft) in diameter, passed 
within 2 Earth radii of the surface of the planet. This is only 45,000 km (28,000 mi).

As mentioned in the opening paragraphs of this article, on September 8, 2010, 
two asteroids passed within the distance from the Earth to the Moon. The closer of the 
two passed within 250,000 km (50,000 miles). The larger one was some 10 to 20 meters 
wide (30-65 ft).

Impact Risk
NASA maintains a table of NEO’s ranked according to the potential of impact 

and damage. This automated “Sentry Risk Table” (available online at 
http://neo.jpl.nasa.gov/risk/) continually scans the asteroid catalog and analyzes the 
potential of impact and compares this probability with potential damage from an 
impact. It calculates orbits for various asteroids up to 100 years in the future.

The greatest probability of impact known to your humble contributor at this 
time is Asteroid (29075) 1950 DA, which has a “significant probability of impact” on 
March 16, 2880.

Could this date be the end of all life on planet Earth?
The current probability for this asteroid to impact the Earth is listed as “less than 

0.33%”, but the calculated orbit is still hundreds of years away. Who knows where this 
Potentially Hazardous Asteroid will be hundreds of years from now? Gravitation 
perturbations are known to change an asteroid’s orbit continuously.

Still, we remain watchful.

References:
• NASA

◦ Near Earth Object Program – http://neo.jpl.nasa.gov/neo/
◦ NASA History, Cosmic Impacts - 

http://www.hq.nasa.gov/office/pao/History/impact.html
• Wikipedia Articles

◦ Near Earth Object – http://en.wikipedia.org/wiki/Near-Earth_object
◦ Spaceguard – http://en.wikipedia.org/wiki/Spaceguard
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Fan Fiction

Mc-A-Prise
by Lieutenant J.G. Peter McMillian

 The time, 26th century. The place, a crowded auditorium at Starfleet Academy. 
A young man stands at the side of the stage. Like most Starfleet cadets of his time he 
is significantly younger then the cadets of the previous centuries. While his brown hair 
and hazel eyes make him look like any other cadet from Earth, his ancestry is only 1/4 
Human. Skown McCallister is the first graduate of the Academy to be a hybrid of 
Human, Vulcan, El-Aurian and Betazoid. Those who know him well know that he has 
incredibly control of both his telepathic and empathic abilities. The only drawback, 
he is unable to contain his imagination and is prone to frequent day dreams.

Admiral McMillian's voice echoes through the hall, “Today we gather here to 
acknowledge all the graduates of 2575. First up, Skown McCallister, one of our most 
promising cadets and this year’s Valedictorian.” He turns to the young man and 
favors him with a smile. “For your excellence in tactical situations, we congratulate 
you and present you with this diploma.” 

Skown ascends the stage and strides proudly to the podium, where he shakes 
the Admiral’s hand and accepts his diploma. Admiral McMillian returns the shake and 
moves over, allowing Skown to address the gathering. The Cadet takes a deep 
breath, looks out over the crowd, and begins. 

“Five hundred years ago our ancestors were recovering from a war that 
decimated almost all of Earth. However, from great violence came an even greater 
peace. It was made possible because we committed ourselves to seeking out new 
life and new civilizations. At first it was rough. Humans and Vulcans didn’t really trust 
each other, but Captain Jonathan Archer made it his mission to treat everyone he 
met as a potential ally instead of an enemy. Today, I, – no I’m sorry WE – stand here as 
proof that peace must be our continued goal in the Federation. There is much more 
to see and much more to learn. I believe one day the Federation will consist of 
species from all quadrants, but until that day comes it’s up to us to be the peace 
keepers of the universe, and we must remember where we came from so we know 
what never to go back to being.” 

Row by row the gathered cadets, brass, and civilians alike stand and clap 
vigorously as he finishes. On their feet now, his fellow cadets stomp their feet, cheer 
and whistle. 

Grinning widely, Skown gives the audience a wave and exits the stage. He 
reaches the last step and turns to return to his place when his commbadge chirps. As 
the cheering ebbs around him, he raises his hand reflexively and taps it, but it 
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continues to beep.....

Skown blinked and looked around. The cheering was gone, and instead of 
standing in a crowded auditorium, he was standing alone in his dorm room. Instead 
of his uniform, he was wearing pajamas, and the incessant beeping was not coming 
from his commbadge but from his computer terminal. 

He frowned as he pressed the incoming message button. “This is Cadet Skown. 
How can I help you?” 

A very stern looking woman with her hair in a tight bun glared out from the 
screen. “It's about time you answered, Cadet. I'm Ms. Melano from Admiral 
McMillian's office. I was asked to contact you and tell you to report immediately to 
the Admiral in the communications room." 

“Tell the Admiral I’ll be there as soon as I can.” Skown answered politely. He 
knew this was reality because if it were a daydream, the woman would be much less 
frightening. 

He dressed quickly then walked the short distance to the comm room. Skown 
knew that transporting would have cut seven minutes of his arrival time but he still 
had not gotten used to the new wormhole-transporter system. 

He spotted the Admiral sitting at the head of the conference table as soon as 
he entered. 

“Cadet Skown reporting as ordered,” he announced, standing at attention. 

….to be continued

[back to table of contents]
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Simming

Log Writing: The ABCs
by Commander Loriarra

 "Logs. I'd like to see more logs."
Have you ever heard that, or something similar, said by your CO or XO? Most 

likely you have, and there is a good reason.
Logs aid character development tremendously. They help players reflect on sim 

events. They fill the gaps in between live sims, or expound on details you could not 
include in sim. Last, but not least, logs get your character promoted!

So, why does log writing sometimes feel more like work than fun? It could be 
your own mindset. Some people excel in recounting sim events, but dread writing a 
narrative. Others love story logs, but can't bring themselves to write reports (maybe it 
reminds them too much of school). Still others might not feel so confident in their 
writing abilities.

Fear not! This is where I come in as your personal tutor to help you expand and 
enhance your ability and joy in writing logs.

In today's lesson we'll only touch on a couple of basic matters: 
• the different types of logs commonly employed by simmers in the USF, and 

what formats can be used to write them 
• "bad formatting", or some common mistakes in presentation that might keep 

your logs from being read

Types of Logs

There are commonly three types of logs found on the message boards: 1) Duty 
Logs, 2) Personal Logs, and 3) Joint Logs.

Duty Logs (DLs) are usually written in a report-type format or as if one is 
recording events into a computer database (first person perspective), as shown in 
many Star Trek series. However, in a broader sense, DL can mean any log that takes 
place while one is "on duty", which means narratives (third person perspective) about 
what your character did on duty can also be considered DLs. (Not all COs agree with 
that broad definition, and you should therefore check with your hosts before posting 
such a log as a DL.)

Personal Logs (PLs) are commonly written in narrative form (third person 
perspective) and chronicle the character's personal life. However, as seen in different 
Star Trek series, at times a person might record a PL into the computer database, or 
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perhaps use some other form of recording, like writing it by hand (all in first person 
perspective).

Joint Logs (JLs) are a special type of Personal Logs; they involve two or more 
simmers writing a narrative together (third person perspective). This calls for 
consideration on each participant's part, i.e. helping with editing, especially since 
these type of logs can get quite lengthy. Because they are a fun group activity that 
draws simmers closer together, many find JLs to be the most enjoyable kind of logs.

 My suggestion, get creative and try exploring some of the formats you might 
have not used yet.

Bad Formatting

Do you at times wonder if anyone even reads your logs? The reason they might 
not could have to do with bad formatting. 

Some common mistakes in presentation - yes, visual is important - that could 
make you lose your reader from the first glance are:

Tiny font
Why a problem? Most of us don't sit at the computer with magnifying glasses in 

our hands, nor do we commonly look for the computer's button to zoom in the 
screen. A reasonable font size would be 12, but remember that not all fonts display 
equally at that size. If it's much smaller than size 12 in Arial, it might be good to dial it 
up a little.

No capitalization and/or punctuation
Why a problem? Our normal reading pattern has been formed since early 

childhood. We rely on visual input that tells us what sort of words we're looking at, and 
when a sentence begins or ends or when there is a pause. Without it, words simply 
flow together into a rhythmless goo of letters. No one wants to try and decipher 
where a seemingly unending sentence should be broken. It's an immediate turn off 
for a reader.

Not at least running a spellcheck
Why a problem? It goes hand-in-hand with the aforementioned; it breaks the 

flow of reading. The eyes and mind stumble over terribly misspelled words as if walking 
on a rocky road. This is an easy to fix problem though. Every email client has a 
spellcheck available. All you need to do is use it before you send out your log. The 
improvement can be tremendous.

Excessive spacing in between lines
Why a problem? Making empty lines in between written lines (by pressing enter 

more than once) is also a flow breaker. Granted, at times I've availed myself of it as 
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well, mostly because for one reason or another I was unable to indent my lines, which 
- believe it or not - helps the eye to move over text more easily, too. However, 
indenting is much preferred to spacing lines apart, if you can help it.

Having your logs littered with strange symbols
Why a problem? This is another flow problem. If there is a strange symbol (like a 

question mark in a diamond, or any other unusual symbol) where there should be a 
space or perhaps a quotation mark, it immediately distracts and cuts the flow of 
reading. Reading the log becomes a chore, rather than fun, no matter how eloquent 
you expressed yourself. The issue usually comes up due to some formatting forced by 
certain word programs. You might do well checking on that to try to avoid it.

Using a script font
Why a problem? Script fonts can be beautiful, looking like handwriting. 

However, they are harder to read than serif or sans-serif fonts. Just look at how much 
easier you can read a book than the handwritten letter from your friend. Using script 
fonts to highlight something is great, but using them extensively in paragraphs can 
easily make your reader lose their focus.

Copy/pasting your log and posting it as a DL and PL
Why a problem? Even if you made slight changes in one of them, your reader 

will soon figure out it's double the amount of reading for the same information and 
get bored with it. One or the other log will usually not get read then, which means the 
reader might also miss out on something important you've included in the one that 
they decided to skip.

Posting Joint Logs as mini-sims
Why a problem? There is a reason why sim chatlogs get posted as raw data. No 

one wants to write it all up in narrative form due to the amount of information. They 
simply serve as records of what took place during the sim. Most simmers never look 
over them again, unless they are searching for very specific information to extract. To 
post a collaborative writing project, such as a JL, simply in a record-type form is a 
shame. It portrays a lack of care for writing. Don't be surprised if the reader shows a 
lack of care for reading.

Super short log parts and super long logs
Why a problem? Posting a normal length log in several super short parts is 

another undesirable way of breaking the flow of a story. Which begs the questions, 
what is a normal length log? The opinions on that vary greatly. I personally don't like 
posting anything that will take the reader more than 5-10 minutes to read, and I have 
posted shorter logs but not super short log parts. It seems utterly unnecessary to break 
a 5 minute log into three or four pieces. The flow of the story gets chopped up, and 
the enjoyment of reading wanes. On the flip-side, super long logs can also be hard 
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on the attention span of the reader. Those might be better off being broken into a 
couple of parts. In the end, use good judgment to help guide you on log length, and 
try to see it from the reader's point of view.

All that said, I hope you will take these simple hints to heart and experience an 
immediate enhancement to your logs and the appeal they have to your audience.

[back to table of contents]

Starfleet Academy 
Abridged Correspondence Courses:

Computer Systems History

Course Designation: Computer Systems and Technology - History 1101

Lecturer: Lieutenant Commander Simon Trent*, PhD, DA**, VSLoH***

Over the last 250 standard years, the Federation has seen quite a bit of 
advancement, new materials in starship design, weapons, and support systems, but 
the basic systems haven't changed much. For example, impulse drive hasn't 
changed at all since it was first introduced in the early to mid 2100s. The transporter 
systems, while getting more efficient, are the same as they were on the NX-Class 
ships. Even communication systems haven't changed much. However, this lesson isn't 
about how things have stayed the same, it's about how things have changed, and 
today we're focusing on Starship Computer systems.

In the early days of the Federation, indeed going back to the United Earth 
Starfleet, the computer system consisted of a server array about the size of most early 
21st century MMORPGs. It worked. It did its job. Over time, as systems became more 
complex, it was found that the data rates from the array to the rest of the ship were 
inadequate. However, the next major advancement wouldn't take place for close to 
100 years when Doctor Richard Daystrom created the first duotronic computer 
system. This quantum leap increased the power of the system an unmeasured 
amount, and it was almost instantly installed into every Federation starship and 
incorporated into every new design.

The next leap forward was again by Doctor Richard Daystrom and would come 
25 years later, the multitronic system. Where the differences begin, that's for a 
historian to figure out. What I do know is that initially the system contained memory 
engrams from Dr. Daystrom himself and caused the project to come to a crashing 
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halt, and the program was stopped. Why I include this is significant. If it weren't for this 
critical error, it's quite possible that the next step, isolinear computer technology, 
might not exist or wouldn't exist until much later.

Isolinear technology contains many different parts. However, the principle is the 
same. It's an internal three dimensional storage system that allows, from a 20th/21st 
century standpoint, an insane amount of storage and access retrieval. Along with 
that technology, the LCARS operating system was developed for wide usage across 
the Federation. The two systems, isolinear and LCARS, allowed other technology to 
advance and is still in use today. However, it is slowly being replaced.

Isolinear's replacement is the bioneural system. Simply put, data is stored and 
transmitted through bioneural gel packs, almost like the central nervous system of a 
living being. Indeed the entire bioneural system has been likened to the human brain. 
It's operating system is still LCARS, which integrates beautifully with the system, 
increasing response time and overall performance of the system.

Where the future goes with advancements, who's to say. Who knows what's in 
development right now? I certainly don't have clearance for that information, but 
where ever the technology advances, I hope that I'll get to see it. 

* Lieutenant Commander Simon A. Trent is currently assigned to Space Station Nigala as both her Chief  
Engineer and as her Second Officer
** Daystrom Award
*** Vulcan Scientific Legion of Honor

[back to table of contents]
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Comics & Humor

“That way, Sir...”

Redneck Engineers...

[back to table of contents]
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Data Network

Trivia
by Captain Stewart Hawks

Anagram Puzzles
An anagram is a word play in which a word or phrase is rearranged to produce 

a new word or phrase, using all the original letters only once.
See if you can unscramble the phrases below to make the names of Star Trek 

actors.

1. I'm only a drone
2. Low age in 'Trek'
3. Sleek or deftly
4. Sane jam hood
5. Slim alien wrath

(Answers can be found at the bottom of this issue.)

Who would have thought?! - The study or collection of trivia is known as spermology, 
which literally means “collection of seeds”.

[back to table of contents]

Did You Know?
by Captain Rosanna Severine

There are many things that you pick up over the years from watching the 
shows, reading about them in magazines, and attending conventions. The actors 
especially love sharing different stories and experiences at the conventions. For this 
first issue, I've just picked out a few bits of knowledge from the memory banks.

Crazy Fans:
Did you know that Brent Spiner (Data from The Next Generation) saw someone 

leaving his yard after they had stolen some of the roof tiles off his home? Insane.

Uncredited Actors:
Did you know that there are quite a few actors uncredited for their roles in the 

series' from TNG on up? A lot of actors didn't want to be listed in the credits as much 
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as they just wanted to be a part of the show—a part of Star Trek. A lot of times they 
were in a lot of makeup, too. So you never know just who has shown up on a Star Trek 
show in disguise.

James Marsters:
Did you know that James Marsters almost won a major role in the movie 

franchise? Better known for the role of Spike on the series Buffy: The Vampire Slayer 
and a slew of other characters, James Marsters was actually one of the final actors in 
the running for Shinzon in the movie Star Trek: Nemesis. Don't believe me? I've seen 
the actor's test screening that he did opposite Patrick Stewart. So I know for sure that 
it isn't just a rumor.

Kate Mulgrew:
Did you know that Kate Mulgrew was not the first woman to be cast as Kathryn 

Janeway? Another actress actually won the part and then decided that she didn't 
want to be Kathryn Janeway. Kate Mulgrew has said before that she's thankful that 
the actress gave up the roll. She enjoyed playing Kathryn Janeway.

Actors are Fans Too:
Did you know that even though several of the Star Trek actors had no idea 

what they were getting into when they joined the franchise, there were many other 
actors that were already fans of Star Trek before their roles were won in later series?

Well, that's all for this edition of “Did You Know”. I hope that you will check out 
further issues of the PADD for more. I'm open to hearing your thoughts about what 
characters, actors, shows, etc. you want to learn about. You can send your 
questions/requests to rosanna.padd@gmail.com. If I don't have the answer, I am 
more than happy to look it up. I do have several sources I can draw from other than 
my own memories.

\\// Live Long and Prosper \\//

[back to table of contents]

“The Forum”

Welcome to The Forum, where everyone gets a say! 

In this section of The PADD, I will be asking each of you to give your opinion on 
several popular, obscure, and nonchalant topics. The main point of this is to allow 
people to get their opinions heard without a rebuttal shooting them down. 
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For example, one topic might be, "Who is the best series Captain?" In this 
context, the term 'best' is subjective, seeing as how there is no way to measure which 
Captain is 'the best', so that is where YOUR opinion comes into play. An appropriate 
answer might be, "Captain Janeway because she carried herself as a tough, 
independent woman who was not afraid to show her sensitive side when it was 
necessary," as opposed to, "Captain Janeway because she's hot."

(To clarify: 'series Captain' means, the Captain who was a main character throughout the  
series, like Captain James T. Kirk and Captain Benjamin Sisko, but not secondary characters like  
Captain Christopher Pike and Captain Rudy Ransom.)

With that in mind, please submit your opinions on The Forum Topic of the Month 
using the feedback link (select “The Forum”), or send them to Solik@sector001.com 
with the following:

• In the Subject line, use the words "PADD" and "Forum".

• Your opinion (Please use proper spelling and grammar.)

• Your name, as you would like to be credited. (I know for some like myself, 
having multiple characters, it is just too hard to choose only one identity!) 

• Finally, your sim, if applicable.

The latter two are completely optional, only if you want public credit for your 
opinion. I do encourage everyone to be as open as you want when submitting, but 
please keep it rated PG-13. Submissions will be presented in each issue of The PADD in 
the order that I receive them. Also, please make sure submissions are sent in by the 
15th of each month prior to the next issue. Any submissions received after that date 
can not be guaranteed to be included.

All that having been said, the topic for discussion for the December issue of The 
PADD is:

Best Science-Fiction Series Besides "Star Trek"

I am looking forward to reading every submission!

Solik

[back to table of contents]
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Photoshop Tutorial
by Captain Havraha cha'AAinkh

Another PADD, another Photoshop Tutorial.  When I passed the PADD torch 
over to the new editor, I was asked if I could continue my Photoshop tutorial series. 
No problem, I said.  I was then asked if I could help make my Photoshop Tutorial series 
more relevant by showing how to do everything I do in GIMP. Big problem, I said.

GIMP, in case you’re unaware, is a free graphics editing program that you can 
download online.  It’s often jokingly referred to as “the poor man’s Photoshop”, and I 
think, personally, this is too much of a compliment.  GIMP is, in my opinion, a rather 
unwieldy program that, yes, can do quite a bit, but can’t do that bit very easily.  It’s 
got a complicated user interface, an inexplicable “floating windows” layout that is 
more at home on a Macintosh than a PC, and on top of that, its filter effects are 
“destructive”, which is simply a term that means “once you apply them, they’re 
applied, and there’s no turning them off”.  

But, that being said, if you really … cannot … find yourself a copy of Photoshop 
anywhere, I suppose GIMP is your best alternative.

In the past, the USF Photoshop Tutorials have never really crossed over to be 
applicable to GIMP before.  Since I found that Photoshop can save you so many 
steps, and GIMP needs so many steps extra, it’s a bit like comparing apples to 
oranges.  Alas, the current Editor of the PADD is right – for all of your toying hobbyist 
who just want to get out, have fun, and make a couple of pretty pictures, perhaps 
adding a GIMP section is a good idea.  

That being said, I braved the storm, wasted a day of struggling, consulted the 
Editor herself, slammed my head into my desk, and ultimately lost brain cells in an 
effort to convert my Photoshop abilities into GIMP abilities for this latest version of USF 
Photoshop Tutorials. So now no one has an excuse not to try some photo 
manipulation! 

And what is today’s project?  Why, I’m going to teach you how to make 
planets.  And not just any planet – we’re going to start small, and then later go big, by 
making a water world. 

Making a Water World - GIMP

Back when I was the editor of The PADD, I liked to make the opening image of 
each issue an individual planet. I made these planets with Photoshop, and I used 
rather advanced techniques and doohikeys I’d gathered from around the internet to 
help make them.

One thing I struggled with, however, was that most of the planet art you see on 
the internet doesn’t necessarily look real. It seems to follow a stylized fantasy kind of 
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look – it’s prettier to look at than the real thing, maybe, but it doesn’t necessarily fool 
you into thinking that maybe you’re actually staring at a distant world that a satellite 
snapped a picture of.

For that reason, studying other tutorials online isn’t always the best approach. 
Pretty much all of these space artists learned or were influenced from one another in 
their style, so to really break from the mold, especially when making planets in GIMP, I 
felt I needed to come up with my own way to do this. Very difficult, considering I 
don’t know GIMP inside and out.

For this first tutorial on 
how to make planets, we’re 
going to make a water world. 
We won't even mess with 
clouds yet, as we will handle 
that in future tutorials, after 
we’ve added land to our water 
world. But the biggest hurdle 
we’ll have to pass is the fact 
that we know really so little 
about what planets look like. 
It’s not like we see planets 
every day, for instance. So 
you’re probably wondering 
what a water world looks like 
yourself. Well wonder no longer.

Earth is a water world, for 
the most part, and what you 
see before you (courtesy of 
NASA) is the most recent and 
detailed picture of our planet 
to date. 

Honestly, I consider it a humbling picture. It shows that, in reality, there’s nothing 
out there. There’s no frills, no double stars in the background glaring into the lens, no 
nebulae for cinematic backdrops. Earth is alone out there, in space. 

The metaphorical marble for the visual has never been more striking than here, 
her edges blur into the surroundings from the haze of the little atmosphere we can 
see, and for the most part… the planet is sinking into the darkness from where it 
emerged. There’s no stars… Earth itself is too bright for the camera to detect the stars 
behind her. 

And most important to us, there’s no detail in the water. It’s simply a canvas of 
gradient hues: deeper in the middle, lighter towards the edges. It’s this we’ll try to 
master in our current tutorial.
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First things first, we’re going to go to File > New and create a new image. When 
the new dialog box pops up, we’re going to specify our dimensions to be 800x800 
pixels.

Some of you may consider this a massive picture – remember, that’s all relative. 
When someone’s monitor’s native resolution is like mine, 1680x1050, 800x800 is just 
“large” and not necessarily “supermassive”. If you feel like you need to work on a 
smaller scale for some of your more personal work, feel free to change the size of 
what we’re doing yourself, but for the purposes of this tutorial I’ll be working at this 
scale.

Now you’ll have a 
blank, white canvas. Next, 
you’ll need to go to your 
Toolbox window and grab the 
paintbucket tool. This ought to 
be a fairly easy thing for you 
to find if you have the toolbox 
window open. Double click on 
the foreground color box just 
below the tools and select a 
nice deep black (black should 
be in 
the 
color 
box by 

default, but in case it is not, you need to click on it and change 
it), and we’ll be good to click on our canvas and drop a whole 
bunch of black paint on it for our backdrop.

With a black canvas now, we’ll need to make a new 
layer again, and then we’ll be able to begin making our water 
world. We’ll do this by finding the Layers window and clicking 
on the new layer button, circled in the picture here.

If you don’t see this window open anywhere for you, 
you’ll need to go to Windows > Dockable Dialogs > Layers, or 
just press CTRL + L.

Next, grab the “Ellipse Select Tool” from the toolbox, or just press E on your 
keyboard, click on the center of your canvas, and start dragging the circle out. While 
you’re dragging, hold SHIFT + CTRL to do two things – constrain your proportions so 
what you’re dragging stays a perfect circle, and make the circle grow from the 
center of where you clicked. This should insure you have a good circle in the middle 
of your canvas.
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This is where my tutorial gets different from what a lot of people might use to 
make the watery gradient. The 
Blend Tool, the tool that some may 
use to achieve a radial gradient in 
GIMP, puts too much emphasis on 
the second color’s dominance 
over the first, and it’s not really 
controllable like it is in Photoshop. 
If you don’t understand what I’m 
talking about, don’t worry about it, 
because it’s really not important. 
What I’m getting at is, we’re going 
to do this differently.

Get the paint bucket tool 
again, select a dark blue color of 
your own preference, and fill the 
circle with it. What you’re probably 
thinking is “That doesn’t look like 
much of a gradient”, and you’d 
be right. We’re half done here. 

Now we’re going to select a much lighter shade of that same blue we used 
first, and again make a new layer. Then we'll go to Select > To Path, followed by Edit > 
Stroke Path, and set the line width to 100 pixels. Then press the button that says stroke. 
What’ll happen is we’ll have a giant light blue stripe inside our dark blue ball.

Now, we’ll go to Filter > Blur > Gaussian Blur, and set the radius to 150 pixels. 
You may be confused because technically there is both a horizontal and vertical 
radius, but as long as they’re linked, they’ll match each other even if you only enter 
one of the values. These steps will make a nice gradient blue ball with the middle a 
deeper and darker color than the edges.

After that, we’ll make another new layer, and then go to Select > None to 
deselect the circle. Now we'll stroke the patch once more by doing Edit > Stroke Path, 
but this time around we’ll set the width to 7 pixels. Because of this, we’ll get a little line 
right around our planet here.
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Then once more go to 
Filter > Blur > Gaussian Blur 
and set the radius to 20 
pixels this time around… and 
the effect of that step will be 
an even lighter edge that 
also puts a little bit of a hazy 
atmosphere on the outside 
of the ball, as depicted to 
the left here.

One final step before we’re done. We’re going to put a big ole shadow on our 
planet. We’ll make another layer, and then go to Select > From Path to select our 
circle again. Now, we’ll go to Select > Grow, and we’ll grow our selection by … oh … 
50 pixels. Select black as a color, get the paint bucket tool, and fill the circle we have 
now with black. 

That looks pretty anti-productive, right? Wrong! Go to Edit > Cut, then Edit > 
Paste, and click and hold down the cursor on the circle to move the selection a bit 
off kilter … about so it’s only covering maybe two thirds of the planet. Click off the 
selection to deselect it.

Our final step? Filter > Blur > Gaussian Blur, and set her to 175!
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And there you have it, a fairly realistic water world in GIMP. Our next section is 
how to do the same thing in Photoshop. 

[back to table of contents]
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Making a Water World - Photoshop

Home Sweet Home!

In this part of the tutorial, I’m going to reiterate what I showed you in GIMP but 
in Photoshop CS5. Remember, you can basically do anything I’m doing in this tutorial 
in Photoshop 7 or above. However, it is very unlikely you will be able to do what you 
see here in Photoshop Elements.

We’re going to start the same way we started in GIMP, File > New and create 
an 800x800 pixel image. Select the paintbucket tool; it may be nested under different 
tools, so hold down your mouse over different icons to see what other tools may be 
available in the stack. Next, pick a black color from the swatches panel, preferably 
true black, and fill the canvas with the selected color on the first layer.

Now make a new layer in the layers panel by clicking 
on the icon (red circle) shown on the left. Next, pick the 
circular marquee tool. It may be stacked underneath the 
rectangular marquee tool on the left hand side. Click in the 
middle of the canvas and hold SHIFT + ALT to constrain the 
proportions and create a circle. From here, we’re going to 
fill the circle.

For the foreground and background colors, which are 
just the terms we use for the two "selected color" boxes you 
see on the toolbar on the left, pick one dark blue color, 
and one more medium blue color. We’re going to use the 
Gradient Tool, stacked under the paintbucket tool, to 
create our gradient effect.

With the gradient tool selected, you’ll see a number of options at the top of the 
Photoshop window. If you don't see them, then that might mean you're using an older 
version of Photoshop, and you may need to hunt down some Gradient options, 
whether they will be on the right toolbar or have their own panel. For reference, I'm 
including a picture of where I'm talking about and what it should look like in CS5, so 
you can look for something similar if you can't find it in your version. 
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Once located, hover over the icons until the option “radial gradient” is found, 
and select it. Now, start from the center of the circle and pull outward. Don’t be 
afraid to go out farther than the circle to get the gradient the way you want it. This 
will create a much more subtle gradient than what I achieved in GIMP.

Next, we’re going to use 
some layer effects to create the 
atmospheric haze on the water 
world. Duplicate the planet layer 
by dragging the active layer on 
top of the new layer icon in the 
layers panel. You can also right-
click on the layer and select 
"duplicate layer". This will create a 
new layer with the same elements 
so we can fiddle with it without 
worrying about potentially 
destroying all the work we’ve 
done. Next to the first planet layer, 
you can click the eyeball icon to 
hide it from view and/or click the 
lock icon to prevent accidental 
changes.

Click the newly duplicated 
planet layer, then click the “FX” 
icon at the bottom of the layer 
panel. There will be a lot of options displayed for you, but we will be using the 
"Blending Options." So, click on the top option which says “Blending Options”. A new 
window will pop up for you that says “Layer Styles”.

Next, you’ll need to click the option titled “Outer Glow”, and fill in the options 
as seen in the picture I’ve included below. Now you can click on the color box to 
select the color of your glow, which should be a pale yellow by default. You can then 
click off screen to select a color anywhere on your canvas; I selected the outermost 
blue on my planet, to make the glow feel very natural and not so much “glowy” as 
much as “atmosphery”.

Now we’re going to do a trick. Make a new layer above the planet layer you 
were just working on, and shift-select both of them. Now, right click one of them and 
select the “Merge Layers” option. What that did was make the outer glow effect we 
just applied no longer an effect, but an actual part of the paint and pixels in the 
image, so it can be edited.

59



Then we make a new layer on top of that. Find the paint brush tool and select 
pure black from the swatches. Next, change the paint brush to a fuzzy brush. If you 
cant figure out what a "fuzzy" brush is, its simply a brush with soft edges as opposed to 
hard, clearly defined ones -- you can tell which ones are which simply by looking at 
the thumbnails for each brush. You should see some fuzzy brushes as options in the 
top left menu bar, but there are other places, like the brushes panel, that you may be 
able to find the same options in.

You can press the arrow to drop 
down some brush options (use the 
brackets - [ and ] - to change the size of 
the brush). You can do the dramatic 
shadow that we did on our GIMP planet, 
or do what I prefer to do, which is haze 
out one side of the world. You may need 
to use a fuzzy eraser (made the same way 
we got ourselves a fuzzy brush, just this 
time we click the eraser tool) to counter 
your own mistakes, because we’re not 
using much of anything to control our 
stroke here. This is truly an artistic process -- 
we add to and take away from the shadow until we get what we want.
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And this is our finished product. If you were going to look at a real water world 
from space that strangely enough had no clouds, this would be what it would look 
like. A gradient blue ball floating in the abyss, more sublime than even Neptune.

Next Photoshop Tutorial, we’re conquering the great blue sphere and setting 
foot on uncharted territory. LAND AHOY!

[back to table of contents]
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USF Cookbook
by Commodore Ray Packard

Though you think summer outing when you hear the word grill, this easy to  
make treat shouldn't be confined to warm months of the year. Grilling enhances the  
natural sweetness of the peaches. 

Grilled Peaches
(Submitted by First Lieutenant Amira Starr)

Peaches (1 half per person) rinsed and pitted Honey
Cinnamon
Nutmeg
Butter
Aluminum foil
Vanilla Ice cream

1. Pull off a long enough strip of foil to wrap peaches in. Use two strips if needed. 
2. Lay the peach halves flat side up. 
3. Drizzle with honey, then sprinkle with the cinnamon and nutmeg. 
4. Lay a pat of butter on each half, then fold the foil so it does not leak any juices. 
5. Place on a heated grill. 
6. Cook approximately 8-10 minutes on each side. 
7. Remove from grill and open carefully not to lose any of the juices. Serve this 

with a dollop of vanilla ice cream. 

(Note: If using more than two whole peaches, you will want to make more than one packet as this can 
compromise the foil packets strength.)

Whenever you can combine comfort food, with time-saving ease, you have a  
winner. 

Mac'n Chili-Cheese 
(Submitted by Lieutenant Falco Fogarty)

1 pkg of Mac'n Cheese Deluxe
1 15 oz. can of chili

1. Boil Macaroni noodles according to instructions on the package.
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2. Heat up chili in a large, deep pan.
3. Drain Macaroni and add to chili, stir well.
4. Turn off heat.
5. Squeeze cheese package over the mixture.
6. Mix only lightly, so that cheese does not completely blend.

French Toast, like French Fries, was not started in France. It's earliest use was  
seen in Spain. Originally made with day old stale bread (It's original name was pain  
perdu, which literally means "lost bread") the recipe still comes together better if the  
bread used isn't fresh from the store/bakery. 

Cinnamon Raisin French Toast

8 slices 1/2" thick Cinnamon Raisin Bread 
4 T. melted butter
3/4 c milk
1/2 c heavy cream
3 large eggs
1 T. honey
1/2 tsp. vanilla extract
1/2 tsp. salt

1. For the French Toast custard, combine using a hand whisk the milk, heavy 
cream, eggs, honey, vanilla extract and the salt. This custard can be made well 
in advance. Give a brisk stir before making the toast.

2. Transfer the custard to a casserole or open shallow dish for dipping.
3. Dip one slice into the custard and turn over after about 15 seconds. Transfer the 

slice to a plate while dipping another slice into the custard.
4. Place a large skillet on a medium fire. Allow the pan to heat thoroughly before 

pouring 1 Tablespoon of the melted butter into the pan.
5. Place both slices carefully into the skillet and cook on each side until golden 

brown or about 2 minutes.
6. Repeat steps 3-5 until all the French toast is cooked.
7. An optional step is to place each finished French toast onto a baking sheet in a 

preheated oven until all are ready to serve.
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The Holidays are fast approaching, which means pie season! And what says  
fall, more than Pumpkin Pie?

Pumpkin Pie

1 1/4 cups pumpkin puree, canned or fresh
3/4 cup sugar
1/2 teaspoon salt
1/4 teaspoon ground ginger
1 teaspoon ground cinnamon
1 teaspoon all-purpose flour
2 eggs, lightly beaten
1 cup evaporated milk, undiluted
2 tablespoons water
1/2 teaspoon vanilla extract
1 unbaked pastry shell (9-inch)

1. Combine pumpkin, sugar, salt, spices, and flour in a medium mixing bowl. 
2. Add eggs; mix well. 
3. Add evaporated milk, water, and vanilla; mix well. 
4. Pour into pastry-lined pie pan. 
5. Bake at 400° for 15 minutes; reduce heat to 350° and bake about 35 minutes 

longer, or until center is set.

Holiday recipes needed for the December issue of the PADD!!  If you would like to contribute 
holiday specific recipes for December, please use the  feedback link (select “Cookbook”) or 

email them to USFRay@aol.com. Recipes need to be submitted by November 15, 2010.

[back to table of contents]
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Gossip & Advice
Captain Alejandra Montoya-Mancuso and Captain Rosanna Severine 
present the first issue of 

“The Tattler”

The Official Gossip Column for the USF PADD

We want to thank all the hosts and officers that sent us gossip for their sims, and 
also thank you for letting us sit in on your sims to observe. Not all sims have gossip, or 
we weren't able to look at all sims. Each issue will depend on just what news is out 
there and who is wagging their tongues. 

(NOTE: This issue features rumored facts and/or fiction from the USS Roddenberry, USS Eclipse, USS  
Odyssey, Starfleet Academy, USS Agamemnon, Outpost Phoenix, USS Federation, USS Lothlorien, USS  
Independence and USS Columbia, as well as some really juicy gossip from the USS Ares!) 

"Well, Rosanna, did you hear the latest about the Odyssey?" 
"Nope, I haven't gotten to that neck of the woods lately," Rosanna says with 

interest.
Montoya leans in towards Rosanna, "I heard that their Science officer, First 

Lieutenant Jake Markson, has the hots for their beautiful ship's counselor, Lisa 
Sakakino!"

"Wow, that's some good news. It's a lot better than what I have from the 
Academy." Rosanna frowns and sighs. "Word around campus is that a lover's quarrel 
between two of our Lagiers might have been the cause for a murder of a cadet!"

Alejandra looks shocked, "OMG! Murder! Well, you will have to let me know 
how that turns out." She shakes her head, then says rather reluctantly, "Well, since we 
are such good friends, I have a few more good tidbits for you. Please, if anyone asks, 
you didn't hear it from me! - Rumor has it that B'Layna Jarke, from the Eclipse, is 
pregnant. Rumor also has it that since her boyfriend is a Chameloid, someone else 
must be the father. Everyone knows it is nearly impossible for a solid to be 
impregnated by a liquid." She nods knowingly. "Uh Uh!" 

Montoya then looks around to see if anyone is within earshot, "Now you know I 
hate to gossip, but the only reason I'm going to tell you this is because I think you 
should stay away from the USS Roddenberry. I was told that Doctor N'alae 
Leonsbanner of the Roddenberry, along with her associate Doctor S'Jenes Alto, must 
be mad scientists because they were both trying to control an aging virus 
accidentally created by Alto. When Doctor N'alae tried to help him stop it, the virus 
started rapidly mutating. It mutates almost every hour! Being airborne it is very 
contagious and can cause a ship-wide contamination such as was seen on the USS 
Hood." Montoya reiterates, "Like I said, stay clear of that ship, my friend, or else you 

65



will have more wrinkles on your forehead then a Klingon does!" 
"Thanks for the heads up," Rosanna shivers as she speaks. "I met Doctor N'alae 

when she was taking some Academy classes to work on her counseling degree in 
addition to her medical degree. Perhaps I need to speak with her academic 
counselor to see if there is something up. That doesn't sound like too stable of a mind." 

Montoya laughs, "Like I said, I ain't one to gossip, but I also just found out that 
the crew of the Agamemnon is marooned on a planet. When First Lieutenant Amira 
Starr, also known as 'Sista Survival', was asleep, a small creature called a skabbit 
made a nest in her hair! Uh huh! What a fashion statement, gives a whole new 
meaning to the term, Rat's Nest!" 

Rosanna laughs hard, and it feels good to laugh after everything that they had 
been going through with the murder investigation at the Academy. "I would pay 
latinum to see a picture of that. Oh my gosh. That's the perfect prank without being a 
prank. You have all the good bits this month. I'm jealous. I might have to turn in my 
gossip queen badge, or pass it on to you." She winks at her friend. 

"Nah, I'll let you keep it for now." Alejandra jokes and winks back. "I was talking 
to Nurse Makkitotosimew Nashota from the USS Federation the other day, and she 
told me that Commander Loriarra has been in to see Doctor Voss for 'physicals' an 
awful lot lately." 

"I hope nothing is wrong with the commander." 
"The nurse has seen them go into one of the private sickbay rooms and spend 

up to a half hour in there many times a week. I mean, I suppose it could all be for 
some serious medical reason, but she said the looks they give each other when they 
come back out ..." Captain Montoya lets the sentence hang there for a few moments 
before she continues. "It doesn't seem like they've been talking about any grave 
illnesses, even if they aren't all smiles afterward. Nurse Makki said she never seen 
Loriarra smile a lot anyways, but Rosanna, you can't hide what your eyes say. Makki is 
pretty sure their eyes are saying something naughty." 

"There isn't too much privacy on a Starship no matter what they say. There is 
always someone who observes something. There are only so many places for secret 
rendezvous' when you are on a ship." 

"True. And... Rosanna," Montoya whispered to her friend, "Don't send any 
unattached cadets from the Academy to OPX when they graduate." 

Rosanna laughs and playfully punches Alejandra's upper arm. "Why wouldn't I 
want to send people your way? That's your command, you silly woman!" 

Montoya smiles knowingly, "Something don't seem right! Every married man on 
OPX is MIA except for that handsome David Bonali, and now HIS wife is MIA! What a 
looker he is. If I were his wife, I wouldn't be gone too long! Uh huh!" 

"You naughty girl! Though I always say, there is nothing wrong with looking." 
"But if there are any unattached ladies out there, they might want to head to 

the USS Columbia. Right now it's an all male crew that could use a female touch. 
Might be a good idea for the Columbia to take a trip to OPX!” She laughs, "OPX 
could use a man's touch as much as the Columbia needs a woman's touch, if you 
know what I mean!" 
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"No matter what anyone says, the best place to be is where there is a happy 
mix of both. Too much estrogen and we might blow up a planet on a PMS day. Too 
much testosterone and it is like a galactic war all the time." 

Montoya nods. "Did you hear that the USS Lothlorien was blown up!?!" 
"No way! That's Books' ship, right? Dang. How did I miss that news?" 
"It's all turned out for the better though. They got a brand new advanced 

Intrepid class ship as a replacement. But then, maybe they shouldn't have given them 
a brand spanking new ship because I heard they lost the new ship in battle shortly 
after that! Their Chief Engineer, Mr. Andrew Costa, was as mad as a Klingon in a cage 
full of Tribbles!" 

"That wouldn't have been a pretty sight. I've been planet-bound for a while, but 
even my Chief Engineering instructor gets touchy if someone messes with his 'labs' 
and mock ups. Engineers are protective of their ships. Sometimes they seem to love 
their ships more than their own children." 

Montoya chuckles, "Rumor also has it that the Independence has a lot of action 
going on these days. Their acting Chief Engineer, Bryan Roberts, was born with no 
vocal cords. He communicates through a voice enhancement device, which is 
usually breaking down and saying things he does not want it to say." 

"That would be interesting. Although Max, an Artificial Intelligence program 
used by Cadet Malachi Styles, doesn't do his talking for him … that thing seems to 
have a mind and a mouth of its own, too. I've heard several reports, and complaints, 
from cadets about the strange voice coming from Mal's pants." Rosanna laughs. 

Alejandra can't help the laugh that escapes before she chuckled her way 
through the rest of her Independence news. "A new female Ensign security officer 
came aboard, and Roberts must have said something she didn't like because she did 
not hesitate to throw him onto the ground and deck him a good one. Gossip on that 
ship is that someone overheard him talking to himself about how much he likes her 
now that she has decked him. I think Mr. Roberts likes the rough stuff, if you know 
what I mean. Uh huh." 

Rosanna practically purrs as she thinks about her Lagier Chief of Security 
Instructor. "Ah the good ole days that I wish weren't gone. I'm starting to wonder if I've 
lost my touch. I haven't had a date in probably a year." 

"No way!" 
They are both interrupted by a blinking light that signals a new communication 

on their private "gossip" channel. Alejandra holds up the PADD to which the data 
transfers, and Rosanna reads the origination point out loud. 

"Hmm … looks like we have a nice little informant from the Ares." 
"And they want to remain anonymous, too. Intriguing. It must be really good 

stuff if they are worried about their identity." 
A woman's voice begins to play over the PADD. "I don't even know where to 

start. There is too much going on onboard this ship. You sure you have the time?" 
Both Rosanna and Alejandra look at each other with identical Cheshire cat 

grins. 
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"Let's see, there's that Garidian scientist. Ever since she's come aboard I've 
heard some weird rumors. Supposedly, she has asked several crew members for 
naked 3D pictures. It seems like she wants to exchange them like someone might do 
with email addresses. Then, she was seen going to the holodeck with that Bolian 
Ensign, Brott. Several times. I dunno what they're doing in there, but it takes hours 
before they exit. It isn't hard to imagine what could be happening. I know for sure 
she's got his 3D image, cause one of my buddies was working on the bridge when 
Brott's naked self popped up on one of the console screens." 

"Now that would be a delightful treat." The two little gossips agree and nod their 
heads. 

The voice continues, "Then there is the new XO. She's Deltan. Whew! You can 
imagine the 'reaction' she gets when she walks by. She brought the new Ops Chief 
with her when she arrived. From what I hear, they had been 'working' together on 
their former ship for a while. He's Efrosian, and you know how free they are with 
intimacy. Combine that with a Deltan ... well, you get my drift. I was told that she, 
Commander Diell, also knows our CO way back from the Academy. They were close 
'friends' then. Uh huh." 

"Hmm," Rosanna turns her head to Alejandra, "Do you think love might be 
blossoming or rekindling on the Ares?" Those hopes are dashed somewhat when the 
anonymous tipper continues with her news. 

"Then there is Captain Havraha. I swear the man puts Captain Kirk to shame. 
I've heard some rumors drifting my way that T'Kiel, the Vulcan Ops/Helms officer, has 
been spotted visiting his quarters on a regular basis. I can't image the Captain putting 
much stock into 'Vulcan meditation'. He's a womanizer, I tell ya! There's that vibe 
between him and Diell, and then the Vulcan, Doctor Swan, and who knows who else. 
Doctor Swan and the Captain are at each other's throats all the time. Supposedly, 
she doesn't like Romulans. Ha! I'm theorizing it's all a ruse and a farce to keep us from 
seeing what's really going on. You know those Romulans … they like when women are 
resistant. Mmhmm." 

Rosanna puts the PADD back down on the desk. "It sounds like there is a lot of 
bump and grind going on in several places in the fleet. I think I'm going to dig a little 
deeper into the other ships and starbases of the fleet. Did someone put something in 
the last batch of rations … or maybe a virus got into the computer's replicator 
systems?" 

Alejandra shrugs, "Or maybe people are just how they always are … good 
gossip material. That's all I have for now. I'll catch up with you when I have more." 

"Always a pleasure old friend."

Have any gossip to pass along? Please use the feedback link (select “The Tattler”) or email 
rosanna.padd@gmail.com.
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“Ask Y”
by Lieutenant Commander James Yosay

Got a nagging question or issue which has been pestering you for awhile? 
Need advice on something you don’t feel comfortable asking anyone else about? 
Looking for relationship help and suggestions?  Can’t figure out what that little red 
button on your console is for?

ASK Y can help you!  I'm James Yosay, or "Yosay" as my friends call me, and 
well known throughout the USF as being one of the most unique characters to have 
the pleasure, or misfortune, of simming with.  With years of experience in the 
relationship field, as well as a vast engineering and common-sense knowledge, I'm 
the man you can turn to.

Recognized as one of the fleet’s top engineers as well as a premier shuttle pilot, 
I gained my experience from simming aboard such famous ships as the Ares, 
Roddenberry, and Federation. I have spent a good chunk of my career on Bersallis III 
at Outpost Phoenix and did a brief stint back at the Academy as an Engineering 
Instructor.

I'm also the proud new father of a baby girl, who is part Siren (mermaid) and 
part Human.

So come and make yourself comfortable on my couch - or for the single ladies 
my lap, whichever you prefer - and let me pass on a little of that special Yosay 
wisdom and charm. You certainly won't be worse off with it!

Use the feedback link (select “Ask Y”) or e-mail your questions and/or comments to 
USFJamesYosay@gmail.com.

[back to table of contents]
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